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111   INTRODUCTION 

The PS15 pulse spectrometer is a teaching tool as well as an excellent unit for 
conducting research in the field of proton NMR spectroscopy. 

This Experimental Manual is a laboratory companion to the Operating Manual of the 
PS15 NMR pulse spectrometer distributed by TEL-Atomic, Inc. 

Each section of this manual provides introductory information about the subject, 
specifies the problem and gives detailed instructions on conducting the experiment. All 
of these experiments have been performed using an off-the-shelf PS15 NMR 
spectrometer and only originally acquired data are presented.  

The purpose of this manual is to show the potential of the use of the PS15 
spectrometer. Teachers and students have freedom in selecting their own samples, 
using the described sequences as well as other pulse sequences which are not 
described.  Acquired data can be manipulated with the tools on the data acquisition 
page or if binary data is exported in ASCII format users, can use their own software to 
perform Fast Fourier Transform or calculate relaxation times.  

A complete treatment of NMR phenomenon is far beyond the scope of this manual. For 
more details refer to textbooks and papers related to specific experiments (see list of 
books and papers in References on page 141). 
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222   FREE INDUCTION DECAY AND SPIN ECHO 

2.1 Theory 

2.1.1 Introduction 
The response of a nuclear magnetic spin system polarized by a constant magnetic field 
B0 to a radio-frequency (RF) pulse, whose spectrum covers the resonance frequency of 
spins, is known as “Free Induction Decay”  (FID). “Free” refers to the fact that nuclear 
spins precess freely in the presence of a polarizing, constant magnetic field B0  - but 
without the presence of an RF field. The FID signal is of fundamental importance for 
pulse NMR spectroscopy as this time-domain signal Fourier transformation leads 
directly to the frequency-domain NMR spectrum. 

2.1.2   Rotating frame  
To describe the phenomenon of FID we will focus our attention on the net macroscopic 
magnetization that obeys the laws of classical mechanics instead of on individual spins 
obeying the laws of quantum mechanics. In this approach we will analyze the 
interactions between the macroscopic magnetization M and static B0 and RF B1 
magnetic fields in a rotating reference frame and note the relaxation effects that follow. 
In this concept the rotating frame moves synchronously with the RF field dramatically 
simplifying the solution of Bloch equations and allows the visualization of effects even 
after relatively complex pulse sequences.  

The spectrometer’s quadrature detector (which consists of two phase sensitive 
detectors) detects both components of the nuclear net magnetization (Mxy) that are 
perpendicular to the constant field B0. The in-phase signal corresponds to the y 
component and the 90o-out-of-phase signal corresponds to the x component of the Mxy 
magnetization. Using complex numbers analogy the y component is called real and x is 
called imaginary part of Mxy vector.  

2.1.3  Π/2 (90o), Π (180o), … pulses 
For a spin system that has been allowed to reach Boltzmann equilibrium, a net 
magnetization is aligned along the B0 or z’ axis of the rotating frame. Suppose an RF 
pulse is applied along the x’ axis. In the rotating frame it will cause precession of Mz 

magnetization about B1 with a corresponding Larmor frequency: . As 1Bγω ⋅=
pt
Θω = , 

in time tp, the angle Θ through which Mz rotates is given by: 

p1 tBγΘ ⋅⋅=  Eq.  1
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The time tp determines the length of the RF pulse that produces a B1 field along the x’ 
axis. Frequently we refer to pulses that tip the net nuclear magnetization through a 
certain angle as Π/2 or Π pulses in radians (90 or 180 in degrees).  

Eq.  1 defines the magnetization tip angle that can be achieved by applying the pulse of 
duration tp and of the induction B1. The upper limit for tp is determined by relaxation 
processes that should be negligible during excitation of the nuclei.  

The induction B1 depends on the power incident in the sample’s coil and on the coil’s 
electrical and geometrical properties. B1 in the sample coil can be estimated from Eq.  
2: 

Vf
QPB

r

1

⋅
⋅

≈  
Eq.  2

P- power of RF pulse 
Q- coil quality factor 
V- coil volume 
fr- probehead circuit resonance frequency 
 
If Q, V, and fr are fixed the only other way to change B1 and as a consequence the 
flipping angle is by changing the pulse power P. In practice this is done by attenuation 
of the maximum value of the pulse power. Due to fast relaxation, solid-state samples 
usually require short and powerful bursts of RF lasting only a few microseconds. Liquid 
like samples, with their relatively long relaxation times, have less critical demands. The 
upper limit for the power of RF pulses is determined mostly, not by physical properties 
of the sample, but rather by the electronic components specifications like maximum 
working voltage (damage of tuning and matching capacitors in the sample probe 
resonant circuit due to arcing) or maximum current (limitations of transmitter’s end stage 
transistors).  

Figure 1a shows an effect of a Π/2 (90o) pulse. Assuming perfect homogeneity of the B1 
field across the sample, and that no relaxation occurs during the time tp following this 
pulse, M lies entirely along the y’ axis. Its fast precession along Bo induces the voltage 
in the solenoid that is a part of the RLC resonance circuit tuned precisely to the 
precession frequency.  As transverse relaxation occurs, the signal gradually decays. In 
a perfectly homogeneous B0 field the time constant of that decay would be T2. Since the 
B0 field is not perfectly homogeneous across the sample, nuclei in different parts of the 
sample experience slightly different magnitudes of B0, and hence precess at slightly 
different frequencies. As a result, the FID signal decays faster with a characteristic time 

. This so-called  “tee-two-star” time includes contributions from a natural process that 
causes nuclei to exchange energy with each other and from the inhomogeneity of the 
magnetic field. The effective speed of spin-spin relaxation is thus described by Eq.  3. 

*
2T
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2
∆Bγ 

T
1 

T
1 1

2
*
2

⋅
+=  

Eq.  3

 
In Eq.  3 ∆B1 is the magnetic field inhomogeneity. The whole term 2/1B∆⋅γ  is called 

 or inhomogeneous broadening as it broadens the natural line width of the spectra 
which is determined only by molecular processes. 

'
2/1 T

In the language of the “rotating frame”, during spin-spin relaxation some nuclear spins 
rotate faster (move clockwise in the rotating frame) and some rotate slower (move 
counter clockwise in the rotating frame) with regard to the B1 field as shown in Figure 
1b. Therefore in the “rotating plane” the macroscopic My component exponentially 
decreases as individual magnetic moments dephase. 

x'

y'

z'|B0

B1

x'

y'

z'|B0

Mz

Power RF pulse ( /2)Π
FID signal

a) b)

Time Time

My

50 V 50 Vµ

faster

slower

 

Figure 1a).  A Π/2 RF pulse and its effect on equilibrium magnetization Mz. b) Gradual 
decay of My magnetization as an effect of the dephasing of individual moments  

Spin-lattice relaxation also occurs as nuclear moments loose energy to their 
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surroundings and the macroscopic magnetization M unavoidably tips back towards the 
B0 field or z’ axis.  

2.1.4 On-resonance and off-resonance 
The RF pulse of frequency ωRF excites only these nuclei that precess with frequency ω0 
within its spectral bandwidth ∆ωRF. Generally square pulses cover a range of 
frequencies wide enough to excite all nuclei in the sample, except some solid-like 
samples. If the frequency of the RF pulse is exactly the precession frequency of a single 
type of nucleus (ωRF=ω0) the phase sensitive detector produces a signal with pure 
exponential decay as shown in Figure 2a. This decay directly corresponds to the 
decrease of nuclear magnetization in the xy plane. 

Time

Time

b)

frequency

ω ωRF 0=

frequency

ω0ωRF

 

Figure 2. a) On- resonance FID (ωRF=ω0). b) Off-resonance FID (ωRF≠ω0). 

Suppose now that the RF signal is slightly different from the resonance frequency of the 
precessing nuclei (ωRF≠ω0). Immediately after the Π/2 pulse Mz lies along y’ axis. 
However, due to the difference in frequencies the magnetization moves relative to the 
rotating frame. The phase sensitive detector senses this movement. It produces an 
exponentially decaying FID modulated by the signal whose frequency is the difference 
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∆ω=ωRF-ω0 between the Larmor frequency of the observed nuclei and the frequency of 
the detector reference (see Figure 2b). A Single-phase sensitive detector does not 
sense the sign of ∆ω. 

2.1.5 Spin-Echoes 
Pulse excitation of polarized nuclear spins was first proposed by Hahn in 1950 in a 
serious of ingenious experiments published four years after the major discovery of the 
NMR effect by groups of Purcell and Bloch. Hahn also introduced the term “spin-echo”. 
Slightly euphemistic, this term combines categories from two extreme fields, quantum 
mechanics and acoustics. 

Hahn realized that the part of the free induction decay signal that vanishes faster due to 
magnetic field imperfections (called inhomogeneity) could be retrieved in a two-pulse 
experiment. Originally he used two consecutive Π/2 pulses separated by a certain time 
delay. It is much clearer, however if one analyzes the appearance of spin echo when a 
Π/2 pulse, followed by a pulse of Π, is applied as suggested by Carr and Purcell two 
years later. The natural FID decay caused by spin-spin relaxation can not be retrieved. 

a) b)

x'

y'

z’IB0

B1

Mz

+My

x'

y'

z’|B0

x'

y'

z’|B0

x'

y'

z’|B0

B1

x'

y'

z’|B0

c) d) e)

-My
fast fast fast

slow
slow slow

(Π/2)X ΠX

FID

spin
echo

τ τ

 

Figure 3. Spin-echo creation after a (Π/2)X-τ-ΠX sequence. a) Pulse of (Π/2)X tips the 
net magnetization from the z-axis on the xy plane. b) Due to the magnetic field 
inhomogeneity “pockets” of magnetizations lose the coherence that manifests in a faster 
decay of My. c) A ΠX pulse applied along the x’ axis after a time τ rotates a whole set of 
differently moving magnetizations. d) In this spin race, faster moving magnetizations 
(clockwise) meet slower moving magnetizations (counterclockwise) exactly at the –y 
axis. e) After an additional time period of time τ the spins generate a strong echo signal. 

The net magnetization M can be considered as a vector sum of elementary 
magnetizations originating from nuclei located in different parts of the sample mi. Due to 
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magnetic field inhomogeneity these magnetizations experience slightly different fields. 
As a result magnetizations in higher fields precess faster, whereas those in a lower 
fields precess slower. Magnetization Mz tipped by a (Π/2)X pulse to the xy plane starts 
to decompose (see Figure 3b) because of two contributions: spin-spin relaxation and 
magnetic field inhomogeneity. The first process leads to an inevitable decay of free 
induction with the time constant T2. Fortunately the second contribution can be 
compensated by an additional ΠX RF pulse (Figure 3c). If   we will see the 
signal from the net magnetization again weakened only by the spin-spin relaxation 
process (Figure 3e). This signal that is made of refocusing almost simultaneously 
magnetizations mi we call spin-echo (SE). Once focused along the –y axis the net 
magnetization loses coherence again unless another RF pulse is applied.  

2
*

2 TT << τ

The Carr-Purcell sequence was originally designed for measuring T2 spin-spin 
relaxation times not affected by magnetic field homogeneity. After (Π/2)X and ΠX pulses, 
separated by a time τ, there will follow a train of ΠX pulses in 2τ intervals with 
consecutive echoes refocused between ΠX pulses. This method suffers, however, from 
accumulative error of inaccuracy of ΠX setting when many ΠX pulses are applied. Even 
a slight inaccuracy of the echo refocusing pulses of CP sequence results in spins 
focusing above or under the x’y’ plane which is the plane of detection causing rapid 
decay of later echoes. 

a) b)
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Figure 4. Spin echo formation under the Carr-Purcell-Meiboom-Gill sequence. 

By shifting the phase of Π pulses by 90o and the use of a Πy pulse instead of ΠX 
Meiboom and Gill modification of CP sequence reduces the effect of the angle rotating 
inaccuracy significantly (Figure 4).  
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The Πy pulse rotates the dephasing nuclear spins 
around the y’ axis. Let’s assume that it is slightly 
shorter than a perfect Πy pulse and is (Π-ε)y. How the 
self-correction of the Πy pulse works is illustrated in 
Figure 5. To simplify the picture, only the movement 
of the magnetization corresponding to faster spins is 
shown in an x’y’ plane. Y’ axis points toward the 
reader. 

a) First pulse, a (Π/2)X pulse, rotates the 
magnetization on y’ axis; the red spot in the 
center represents its MY’ component. 

b)  As spins loose coherence due to spin-spin 
relaxation process, faster spins start to move 
clockwise; from the reader’s perspective, 
toward left. 

c) (Π-ε)Y pulse rotates the cluster of fast spins 
along y’ axis. As the rotation angle is smaller 
than 180o the cluster of spins does not reach 
x’y’, but the plane above. 

d) Spins continue to move clockwise (toward left). 
e) Spins form first echo when they reach y’. Echo 

is formed above x’y’ plane and its xy 
component is smaller than when an exact Π 
pulse is applied.  

f) Spins start to dephase again. 

g) The second (Π-ε)Y pulse moves the fast cluster 
of spins exactly on x’y’ plane correcting the 
error of the first pulse. 

h) Spins dephase and move toward Y’ axis. 
i) Spins meet again at y’ axis and form perfect 

echo in xy plane.  Process repeats for next 
(Π-ε)Y pulses. Every time odd echoes are 
slightly displaced, whereas even echoes focus 
along Y’. 
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Figure 5. “Self-correcting” properties of ΠY pulses 
in CPMG sequence. Only cluster of faster spins 
are shown. 
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2.2 Experimental 

2.2.1 Obtaining on-resonance FID 
Introduction 
Obtaining an on resonance free induction decay signal is essential for understanding 
physical and instrumental details of NMR pulse spectroscopy. The experiment requires 
using any one-pulse sequence. You can apply either the 1P_X, 1P_-X, 1P_Y or 1P_-Y 
sequence to prepare the necessary setup as described below. Either sequence will 
allow you later to acquire and store data in the file.   

Directions 
We strongly recommend the use of the glycerin sample as it displays some physical 
properties (short relaxation and abundance of protons) convenient for quick setup and 
fast data acquisition. 

For details on how to obtain an on-resonance FID from a glycerin sample, refer to the 
comprehensive instructions in the Operating Manual or modify parameters of the 
Setup page as shown in Figure 6. 

 

Figure 6. Preparing on-resonance one-pulse experiment. 
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2.2.2 Determining Π/2, Π, 3/2Π... pulses 
Introduction 
The RF pulse rotates the magnetization by a certain angle from its equilibrium position 
along B0 the static magnetic field.  It is of utmost importance to know Π/2 and Π for 
further spin-echo experiments and relaxation measurements. This experiment helps one 
to determine the correct length for Π/2, Π, 3/2Π and any other pulse that rotates 
magnetization. 

Object 
Determining Π/2, Π, 3/2Π pulses by measuring the FID’s signal amplitude dependence 
on pulse length. 

Directions 
• Start 1P_X one-pulse experiment. 
• Achieve on-resonance conditions in one channel (I or Q checked) with no 

attenuation of the RF power (Transmitter>Attenuator main=0). 
• Move data marker beyond the “dead time’; usually 25µs is enough. 
• Set pulse width to minimum 0.2µs (Programmer>X_1 =0.2µs). 
• Compensate DC offset to zero (DC level slider). 
• Read and record the FID amplitude in the marker position. 
• Repeat previous measurements every 0.2µs to about 15µs. 
• Plot FID amplitude vs. pulse width (see example in Figure 7). 
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Figure 7. The amplitude of FID signal induced in the RF coil plotted against the RF 
pulse width.  
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• From the plot determine the length of Π, Π/2, and 3/2Π pulses: 
 first maximum corresponds to use of Π/2 pulse (read line at 2.2µs),  
 first transition through zero is caused by Π pulse (blue line at 

5.4µs),  
 first minimum is due to 3/2Π pulse (green line at 7.6µs), etc.  

Note that Π pulse is not simply twice as long as Π/2 pulse. This effect is of 
purely instrumental nature. 
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2.2.3 Adjusting phase for the spectrometer phase detector 
Introduction 
The amplitude of on-resonance FID after phase detection strongly depends on the 
phase of the reference signal. Researchers can not afford to loose or have an error in 
the signal that latter will affect the precision of measurements. 

The analysis of the phase detector operation (see page 76) shows that a maximum of 
the detected on-resonance signal can be achieved when the phase of the RF 
modulated FID (remember that FID you see is simply an alternate electric current 
induced in the resonant circuit coil by processing nuclear magnetic moment) differs from 
the reference signal by 0o. A digitally controlled electronic circuit, called phase shifter, 
introduced into the reference signal path of the PS15 enables the change of the phase 
by 2o. 

Object 
Finding the right phase shift of the phase detector reference signal.  

Directions 
• Start 1P_X one-pulse experiment. 
• Achieve on-resonance conditions in one channel with Π/2 pulse. 
• Move data marker beyond the “dead time”. 
• Set phase of reference signal in the phase sensitive detector to zero 

degree  (Receiver>Phase = 0) 
• Compensate carefully any DC offset to zero (DC level slider). 
• Read and record the FID amplitude in the marker position. 
• Repeat previous measurements every 2o from 0o to 258o. 
• Plot FID amplitude against the phase. 
• Find the maximum on the plot that corresponds to optimum phase shift 

(140o in Figure 8). 
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Figure 8. FID amplitude plotted against phase of reference signal. 
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2.2.4 Fast Fourier Transform of FID signal. 
Introduction 
Short RF pulses can excite nuclear spins in the frequency region of the spectrum these 
pulses generate. Square pulses (called “hard pulses”) cover a wide range of 
frequencies around the carrier frequency fRF established by a quartz generator or 
frequency synthesizer. Other than square shape pulses (called “soft pulses”) produce 
narrower spectrum and are more selective in terms of frequencies that they cover. 

In response to the RF pulses, spins generate a time dependent signal that can be also 
analyzed in terms of spectral contents. Fourier transform is a mathematical operation 
that transforms function from time domain to the frequency domain. Fast Fourier 
transform (FFT) is an efficient computer algorithm for performing the discrete Fourier 
transform for a finite number of 2n data points.  

 
free induction decay                              NMR spectrum             

FFT 

 

For instance an exponential function in time domain function and a Lorentzian function 
in frequency domain are Fourier transforms of each other. In nuclear magnetic 
resonance this exponential function is represented by exponentially decaying free 
induction decay and Lorentzian function describes the spectrum by using FFT. 

Unlike continuous wave spectroscopy that scans slowly through a whole range of 
frequencies, the pulse FT NMR technique applies a radio frequency pulse containing all 
of the necessary frequency components in a preparation period. In the detection 
period that follows the response from nuclei is recorded and can be quickly converted to 
the spectrum.   

A great advantage of FFT NMR lies in its ability to rapidly acquire a signal as well as to 
do signal averaging in the process called accumulation. The enhancement of signal to 
noise due to accumulation is carried over to the spectrum. 

FT NMR perfectly fits these digital times as it benefits from the rapid development of 
fast processors and availability of memory. 

Object 
The acquisition of the off-resonance FID in two channels of the phase sensitive detector 
and conducting the Fourier transform of the signal. 

Directions 
• Start 1P_X one-pulse experiment with two active channels (Data 

acquisition>check channels I and Q) 
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• Achieve off-resonance conditions by changing Magnet stabilizer>∆f0 to 
see a dozen of oscillations on FID. 

• To achieve maximum signal set pulse width as Π/2. 
• Set Dwell time to 20µs. 
• Carefully cancel any DC offset in both channels by DC level function.  

 

Figure 9. Setup page with off-resonance one-pulse experiment. 

• In the Acquisition page acquire FID with several accumulations. Save the 
FID in a file.  

• In the Processing page load acquired data. 
• Click on FFT function. 
• Correct phase to obtain pure absorption spectrum. 
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Figure 10. Applying Fast Fourier Transform (FFT) to FID. Signal from glycerin sample 
obtained after 4 accumulations at room temperature. 

• Check the influence of Left Shift (LF) and Exponential Multiplication (EM) 
of FID on the corresponding spectrum. 
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2.2.5 Liquid-like and solid-like samples.  Comparison by NMR. 
Introduction 
Liquids and solids present two extreme cases for NMR spectroscopy. 

Liquids permit the movement of molecules that consequently average internal magnetic 
dipole-dipole interactions. If not averaged, the dipole-dipole interactions can generate a 
locally additional magnetic field in the vicinity of the nucleus under investigation which 
will modify (broaden) the constant magnetic field B0. Thus NMR lines from liquid-like 
samples are usually very narrow. 

On the other hand the rigid structure of solids limits the freedom of molecular motion 
preventing time-averaging of local interactions and therefore produces a local magnetic 
field. This internal field is responsible for the dramatic broadening of the spectrum. 

Object 
Comparing shapes of FIDs and spectra in distilled water and acrylic sample.  

Directions 
• On the Setup page prepare off-resonance one-pulse experiment with the 

glycerin reference sample. 

 

Figure 11. FID and corresponding spectrum in distilled water. Note 56 Hz line width. 
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• Replace glycerin with distilled water. As water contains more protons per sample 
volume you will see a stronger signal so decrease Receiver Gain. Due to water’s 
long T1 relaxation time increase repetition time TR to 20 seconds to avoid 
saturation effects which reduces S/N ratio. Modify DW and NOP to see the whole 
FID and a long base line. 

• On the Acquisition page acquire FID with 16 accumulations. 

• Replace water by acrylic sample.  

• Modify Setup page: increase Receiver gain (less proton than in water), 
decrease DW (broader line much shorter FID) to a minimum of 0.4µs and NOP to 
512 or 1024, reduce acquisition delay time 2µs below spectrometer’s “dead 
time”. Do not be surprised to not see any oscillations on FID. They are invisible 
due to the enormously broad spectrum of the NMR signal from acrylic. 

• On the Acquisition page acquire FID with 128 accumulations. The signal from 
acrylic is much weaker than signal from water and its strongest element (about 
25% in time scale) is unfortunately lost due to “dead time”. 

 

Figure 12. FID and corresponding spectrum in acrylic sample. Note 25,000 Hz line 
width! 
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• On Processing page estimate FID duration time1, do FFT, correct spectrum 
phase and measure spectrum line width for both samples. 

Table 1 summarizes results of measurements. Note that FID from water is much longer 
than FID from acrylic. As a consequence NMR spectrum in water is narrow, whereas in 
acrylic is extremely broad. 

Sample Phase FID duration Spectrum 

Distilled water liquid 35ms 56Hz 

Acrylic solid 80µs 25 kHz 

Table 1. Comparison of FID duration time and spectrum width in distilled water and 
acrylic samples. 

 

                                            
1 Remember to add the acquisition delay time, when FID signal was not recorded 
(usually about 20µs). It significantly contributes to short FIDs. 
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2.2.6 Two exponential free induction decay in wood 
Introduction 
Some substances display properties of both liquids and solids. Wood is a good 
illustration of this case. It contains free, mobile water in capillaries and bound, highly 
rigid water. The free (liquid-like) water is responsible for the long component in FID 
signal, whereas bound water (solid-like) for its short component. After Fourier transform, 
free water is responsible for the narrow peak and bound water for the wide part of the 
spectrum. 

Object 
To detect FID signal from protons located in free and bound water in a wood sample. 

Directions 
• On a Setup page prepare an on-resonance one-pulse experiment using 

the glycerin sample. 
• Switch samples and modify Receiver Gain, data acquisition time (Dwell 

time and Number of Points). Follow screen capture in Figure 13. 

 

Figure 13. On-resonance FID signal from a dry wood sample. 
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• Acquire FID on the Acquisition page with 128 or more accumulations. 
• On Processing page load experimental data and perform Fast Fourier 

Transform. Estimate manually the line width of the broad  and narrow 
component.  

 

Figure 14. FFT of free induction decay acquired from dry wood. For experimental setup 
refer to previous figure. Narrow peak is from water in capillaries, broad component 
originates from bound water. 

In the example given in Figure 14 broad component is about 65 KHz and narrow one is 
about 1kHz. For comparison of FIDs duration times and spectra width see Table 2. 

& Please keep the wood sample dry to avoid a strong signal from the 
free water that is responsible for the narrow peak in the center of the 
spectrum. 

 

Component FID/spectrum FID duration Line Width 

long/broad 1ms 1kHz 

short/narrow 40µs 65kHz 

Table 2. FIDs duration time and corresponding line width of two exponential decay in 
wood sample. 
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2.2.7 Obtaining off-resonance Spin-Echo 
Introduction 
Obtaining a spin echo signal requires the application of a two-pulse sequence. 

 ΠdelayΠ/2 −−

Use 2P_X_D or HAHNECHO sequence. The 2P_X_D sequence consists of two pulses 
applied along the x’ axis, separated by time delay tD. The length of both pulses as well 
the time delay is available on the Setup page. The HAHNECHO sequence is a 
simplified version of the 2P_X_D sequence, where the second pulse is automatically set 
twice as long as first one is. It is very convenient for fast generation of Hahn’s spin-
echo. 

Directions 
• With a one-pulse sequence (1P_X preferably) determine the correct 

conditions necessary to acquire an on-resonance FID after a Π/2 pulse. 
Write down the value of the field (f0/B0 and ∆f0/∆B0) and the length of Π/2 
pulse. 

• Change the magnetic field using the Magnet stabilizer>∆f0/∆B0 function. 
Usually adding or subtracting 500Hz is enough to see dozens of FID 
oscillations i.e. beats between the reference signal and the FID signal 
from precessing spins in the phase sensitive detector. If a larger offset is 
required, change f0/B0 by one step. The maximum number of steps 
available are a maximum of two steps below and ten above the 
frequency/magnetic field center. Each step coarsely changes the magnetic 
field by 4.4 kHz/ 0.1 mT. Remember when the value of f0/B0 is changed 
the program automatically starts to lock at this new field. It takes about 
three minutes to complete the lock procedure.  

• In the Programmer select the method: 2P_X_D. Use the value of the Π/2 
pulse determined in the previously described experiment with FID, as the 
first pulse value. The second pulse should be made twice as long as the 
first pulse.  

• Run the pulse programmer if it is in a Stop mode. You should see the 
picture similar to the Figure 15.  

• Select the triggering of the acquisition either after the first or after the 
second RF pulse. Triggering the acquisition after the first gives you access 
to both FID and SE signals. Triggering after the second pulse gives 
access to only the SE signal. 

• You may need to change the data Acquisition time to cover the duration 
of FID and the whole spin echo signal, depending of the triggering mode. 
Proceed to Data acquisition and change either Dwell time (DW) or 
Number of Points (NOP) to get the necessary “time window” that will 
cover FID, spin-echo and some of base line noise (Acquisition time = 
DW x NOP).  

• Go to the Acquisition page to acquire data. Type the file name and the 



PS-15 experimental manual   Page 29   

number of accumulations to be performed and run the experiment. 

 

Figure 15. Off-resonance Free Induction Decay and Spin Echo signals after two pulse 
sequence. Spike between FID and SE corresponds to the second pulse. 

2.2.8 Obtaining on-resonance Spin-Echo 
Introduction 
To check the influence of the pulse power and length on the spin echo picture go to on-
resonance conditions. On-resonance spin echo is very sensitive to the B0 field 
instability, B1 field inhomogeneity, as well as the pulse and reference phase.  

&It is rather difficult to acquire on-resonance spin echo in a perfect 
shape and keep it in long time. PS15 pulse spectrometer provides excellent 
long-term magnetic field stability by locking field to resonance on 19F nuclei 
(NMR lock). 
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Directions 
To see nice spin echo you may need to adjust several times following:  

• ∆f0/∆B0,  
• pulse length,  
• phase, 
• gain, 
• sample position.  

Figure 16 shows on-resonance free induction decay and spin echo signals from a 
glycerin sample taken at room temperature. The spike between FID and spin-echo is a 
refocusing Π pulse that follows Π/2 after delay TD. The center of the spin echo is exactly 
at 2TD. Note the spin-echo signal has inversed polarity with regard to the FID signal as it 
represents the magnetization component that is produced along the –y’ axis.  

 

Figure 16. On-resonance FID and spin echo signal in two-pulse sequence 
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2.2.9 Rotating the magnetization along different axis. 
Introduction 
The analysis of interaction of the RF pulse with nuclear magnetization M in a constant 
magnetic field B0 is simplified in a reference frame that rotates with the Larmor 
frequency 

r
.  At resonance (00 Bγω

r
⋅−= RF0 ωω = ) the component originating from the 

B0 field is cancelled and only the B1 component interacts with the magnetization. In a 
rotating frame, magnetic field B1 becomes constant and exerts a torque on a magnetic 
moment moving it along B1 with angular speed 1Bγω

rr
⋅−=  (in the same way, the B0 field 

causes precession of M in a laboratory frame). If after a time tp, the B1 field is turned off 

the movement of magnetization stops and from angular speed definition 
pt
Θ

=

tBγΘ

ω  we can 

calculate a rotation angle using formula p1 ⋅⋅= . Figure 17 shows magnetization 
rotation caused by B1 field at several steps. 
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M
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θ(t )p

  

Figure 17.  Precession of the nuclear magnetization M
r

, around  field in a rotating 
frame. 

1B
r

For further considerations, we will assign RF pulses along any axis in x’y’ plane. The 
Spectrometer, however, can generate only four types of pulses with their phase shifted 
by 0o, 90o, 180o and 270o (phase shift is measured with regard to the first pulse so by 
definition its phase is 0o). We assign arbitrary B1 direction of these pulses along +x, -y, 
-x, +y, respectively. Of course any other assignment of axis is entirely justified. 

The phase sensitive detector traces changes of magnetization within the rotating frame 
due to application of the RF pulse.  With a phase shift of the reference signal properly 
adjusted, the detector produces an electric signal that is proportional only to the 
amplitude of the magnetization component along the y’ axis.  
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Object 
• Observation of the effect of the RF pulse phase on nuclear magnetic detection in 

a rotating frame.  

• Acquisition of FID signals after 1P_X, 1P_-X, and 1P_Y pulses.  

&Note the inversion of the FID after 1P-_X pulse and disappearance after 1P_Y. 

Directions 
• Use a glycerin sample that produces a strong NMR signal. 
• Modify Setup to obtain on-resonance FID after one-pulse 1P_X sequence. 

Screen capture in Figure 6 may help in preparation. 
• Adjust the phase of the reference signal (Receiver>Phase) to see the 

strongest positive signal after detection. This signal represents the 
projection of the macroscopic magnetization on y’ axis (see Figure 18). 

y’

z’|B0

x’

MZ

B (+X)1

x’

MZ

MY

  

Figure 18. Flipping the magnetization on X’Y’ plane by Π/2 pulse along the X’ axis 
(1P_X).  Experimentally acquired FID is on the left and vector diagram is on the right. 

• Change the phase of the RF pulse by selecting 
Programmer>Method>1P_-X. This pulse rotates the magnetization along 
the  –X axis (180o phase shift). Without manipulating the receiver phase 
you should see inversion of FID shown in Figure 19. 
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Figure 19. Inversion of the FID polarity after the use of Π/2 pulse along the –x axis 
(1P_-X). 

• Now apply the pulse along the y’ axis. This pulse moves the magnetization 
on the –x’ axis. If the phase of the pulse is exactly 270o and the pulse is 
exactly a Π/2 pulse, the magnetization component along y’ axis should be 
zero (see Figure 20).   

y’

z’|B0

MY

x’

1

MZ
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Figure 20. Disappearance of FID signal after applying a Π/2 pulse along the y’ axis 
(1P_Y). The little trace of FID is due to inaccuracy of setting the length and the phase of 
the exiting pulse.  

You can “see” My aligned along –x axis (rather phase detector can detect it) if you will 
now change phase of reference signal. Of course change by +/-90o delivers the best 
effect. 
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2.2.10  Signal-to-Noise measurements 
Introduction 
Raw data acquired in an NMR experiment (FIDs or spin echoes) usually require further 
processing to obtain spectra or relaxation time values. Regardless of the method of 
processing, raw data must be free of disturbances that may affect final results. 

 NMR signals are extremely week and usually disturbed by noise of various origins. The 
desire of people designing NMR equipment is to minimize inherent noise that the 
spectrometer may introduce. This can be achieved by use of low-noise components, 
elimination or shielding sources of potential interferences, and signal filtering. 

On the other hand researchers can maximize signal amplitude by optimizing the 
experimental parameters like RF pulse width (to achieve a correct flip angle), repetition 
time (to avoid saturation), selecting correct filters in the detector and adjusting the 
position of the sample. 

The parameter that describes the spectrometer’s ability to detect weak signals is Signal-
to-Noise ratio (SNR or S/N). It gives a measure of spectrometer sensitivity and allows 
the comparison of one spectrometer to another. 

The popular definition of SNR is the ratio of the peak of the observed signal to noise 
peak-to-peak.  

The signal peak amplitude can be easily determined as a tallest peak in the region if it 
is visible from noise background.  

The noise peak-to-peak can be approximated as double root mean square of several 
data point amplitudes taken in the area of pure noise.   

 

 

Eq.  4
n

A
2peaktopeaknoise

n

1i

2
i∑

=⋅=−−

Where: 
- Ai is noise data point amplitude,  
- n is number of points used for calculations and should be reasonably large to minimize 
statistical errors. 

If the noise background has a random character, then investigators have a powerful tool 
to increase Signal-to-Noise ratio, namely, signal averaging. Averaging depends on the 
acquisition of consecutive signals and adding them. In this process non-coherent noise 
reduces gradually to zero whereas coherently appearing NMR signals add and 
gradually increase the effective amplitude.  

Assuming the presence of random noise only (called “white noise”) the average 
improvement of Signal-to Noise ratio is proportional to the square root of the number of 
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accumulations N (see Eq.  5). 

 Eq.  5NSNR ≈

For example to double Signal-to-Noise ratio approximately four as many signals must 
be acquired.  

Object 
Signal-to-Noise ratio measurements of the FID signal. The same measurements can be 
performed with the spectrum. We strongly recommend to do FFT of acquired FIDs and 
compare results of S/N in FIDs and spectra. 

To illustrate the improvement of SNR we will do different numbers of signal 
accumulations of a FID from a polymer sample that has a short and weak signal.  

Directions 
• Achieve on-resonance conditions with glycerin sample and one-pulse 

sequence 1P_X [(Π/2)x pulse] and repetition TR=500ms). 
• Remove the glycerin sample and place the sample labeled as delrin in 

the sample holder. 
• In Data acquisition select Channel I, set Dwell time to 0.4µs, number of 

points NOP= 512. 
• In Receiver set Gain and Phase to see good signal but with a lot of noise. 
• Carefully compensate any DC offset by DC level. 
• On the Acquisition page acquire FIDs with N=1,2,4,8,16,32,64,128 

accumulations and store them in separate files. 
• On the data Processing page load raw data. 
• Measure peak amplitude of the FID and take 15-20 samples of noise from 

the signal “tail”. 
• Calculate noise peak-to-peak as double rms noise level and SNR (see 

equations). 
• Repeat measurements and calculations for all number of accumulations 

N. 
• Make plot of SNR versus N. 
•  To accelerate calculations you can export raw data as text files and 

import them to any popular spreadsheet program like Excel. 

Figure 21 shows collections of FID signals for different accumulation numbers. A 
significant decrease of noise due to averaging process is visible. 

Calculated values of SNR presented as a function of the number of accumulations are 
shown in Figure 22. Small insert in the figure illustrates the almost linear dependence of 
(SNR)2 versus N for high values of N. For small values of accumulation numbers the 
SNR improves faster. 
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100 data points window (39.6us) used for 
noise determination in S-N calculations
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Figure 21. Noise reduction on the FID signal due to averaging process.  
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Figure 22. Signal to noise ratio S-N measured for FID in a polymer sample as a function 
of the number of accumulations N.  
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2.2.11 Spectrometer ”dead time” 
Introduction 
The nuclear spin evolution due to an RF pulse can not be registered immediately after 
the end of the RF pulse because some valuable information is irreversibly lost. This 
happens because of the temporary overloading of the sensitive receiver by a powerful 
RF pulse. The receiver returns from saturation to function normally after a time called 
the  “dead time”. Data acquisition must be postponed for a time longer than the “dead 
time” as shown in Figure 23.  

Data Ac

RX

ACQ quisition

detected signal

" "dead time

TX
RF pulse

 

Figure 23. Postponing data acquisition to eliminate spectrometer “dead time” problem. 

Quality factor (Q) of the probehead resonance circuit that operates as transmit-receive 
antenna and pulse power are major contributors to the “dead time”. High Q resonant 
circuits tuned to frequency fRF have tendency to store RF pulse energy longer and as a 
consequence they ring longer after the pulse stops.  

The falling time Tf of the RF pulse in a resonant circuit that is mainly responsible for 
ringing is related to frequency and quality factor by formula: 
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 Eq.  6

RF
f f

QT ≅

The PS15 has a built-in multiplexing system that directs RF pulses from the transmitter 
to the resonant circuit while blanking the sensitive preamplifier and thus protecting it 
from high power during the transmit period. During the receive period the transmitter is 
disconnected and the preamplifier input is open.  

The operator can delay the acquisition manually to eliminate all affected data points 
from registration. For the safety of the preamplifier, this delay can not be shorter than 
2µs.  

Effective “dead time’ varies from model to model and is usually less than 20µs and 
depends very much on the total amplification of the receiver.  

Object 
Measurement of spectrometer “dead time”. 

Directions 
• Prepare a one-pulse experiment with the acrylic sample that gives an 

extremely short and weak FID signal (shorter than 75µs). To avoid 
integration of the fast transients remember to reduce the RC filter time 
constant to 1µs (Receiver>Time constant>1µs). 

• Set data acquisition for shortest Dwell time of 0.4 µs and number of 
points NOP=512. This gives a correct time scale to watch what happens 
during the beginning of data acquisition. Set acquisition delay time to 
minimum (2µs, see figure on left) . 

• Remove the sample. 
• Place the data marker on the end of the transient and read time (Figure 

24). Add additional 2µs and this is the “dead time” for your particular 
probehead. “Dead time” in Figure 24 is (2+15.2)µs =17.2µs. 

• Insert sample and watch how FID superimposes on “dead time” transients 
(Figure 25).  

• Remove sample again. Increase data acquisition delay from 2µs to 20µs 
and watch disappearance of unwanted transients (Figure 26). 

• Place the sample back in the sample holder and look at “clean” FID. 
Figure 27 shows undisturbed FID from acrylic. Compare it to results in 
Figure 25. 
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Figure 24. Measuring “dead time” of unloaded resonant circuit in PS15 probehead. 
Transients disappear after (2+15.2)µs though RF pulse lasts only 2.2µs. 

 

Figure 25. FID signal from acrylic sample disturbed by 17.2µs “dead time”.   
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Figure 26. Postponing acquisition by 20µs removes "dead time" transients from the 
acquisition window. Note that base line is entirely flat. 

 

Figure 27. With 20µs acquisition delay data window shows only "clean" part of FID 
signal. Operator can achieve the same effect by Left Shift (LS) operation on the 
Processing page. 
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333   NUCLEAR SPIN-LATTICE T1 RELAXATION 
MEASUREMENTS. 

3.1 Theory 

Description 
At the equilibrium state all nuclear moments in a sample are distributed among the 
energy levels according to Boltzmann law. The Boltzmann distribution slightly prefers an 
orientation of nuclear moments towards the polarizing field B0. This preference builds a 
minute nuclear macroscopic magnetization M0 along the B0 field.  Following any 
process which disrupts this distribution, eg. applying RF pulses, the nuclear spin system 
returns to equilibrium with the surrounding lattice by a process called spin-lattice 
relaxation that is characterized by a time T1. 

Pulse NMR provides the most versatile method to measure T1 relaxation times over a 
wide range of times. In this manual we will analyze and apply the Inversion Recovery 
and Saturation Recovery methods for T1 measurements. 

3.1.1 Inversion Recovery method 
Among different sequences used to measure T1, Inversion Recovery is the most 
popular one. It consists of two pulses: a Π pulse and Π/2 following pulse separated by 
variable delay time tD (see Figure 28).  

tD

Π Π/2

U~M(t )D

 

Figure 28 Inversion-recovery sequence. Note that no signal arises after first Π pulse. 

The first Πx pulse flips the nuclear magnetization onto the  –B0 direction. Due to 
relaxation processes between nuclear spins and the lattice the magnetization returns to 
its equilibrium from –M0 through all intermediate values to +M0 along +B0. The recovery 
of the magnetization is monitored after a delay time by a second (Π/2)x pulse. The 
amplitude of FID is proportional to the nuclear magnetization. To avoid any interference 
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from the receiver “dead time” generated after a (Π/2)x pulse the FID should be sampled 
after some additional delay. Figure 29 shows an example of the exponential increase of 
FID amplitude corresponding to recovery of nuclear magnetization from –Mz to +Mz. 
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Figure 29. Gradual net magnetization recovery from –M0 to +M. 

To make calculations simple, each experiment, for a certain delay, must start after 
magnetization completely returns to equilibrium. This is achieved by waiting a sufficient 
time TR (Repetition Time) for a complete recovery after the 90o pulse, (after TR=5*T1 
the nuclear magnetization returns to 99.9% of the initial magnitude). 

3.1.2 Solving Bloch equation for the Inversion Recovery method 
Recovery of the magnetization is given by the Bloch equation: 

 Eq.  71/) T0zz M -(t)(M -  (t)/dtdM =

Assuming complete inversion after first pulse at t=0 we have Mz(0)=-M0.  Integrating the 
above differential equation gives: 

 Eq.  8))exp(-t/T*2 - (1M   (t)M 10z =

Or in linear form: 

 
Eq.  9

t
T
1-   

2M
(t)M-M

10

z0 =⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
ln

Thus T1 can be found from the measurements of Mz (t) as a function of the time delay tD 
between Π and Π/2 and the further fitting of experimental data to the equation Eq.  9. 
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In experimental practice Eq.  9 can be expressed in terms of spectroscopy measurable 
parameters:  

D
1

0D0 t
T
1ln2A)A(tln(A −=−

1T0.69Tln2t 1D

 Eq.  10

Where:  

A0 is FID amplitude at the time when magnetization returns to equilibrium state 
(corresponds to M0),  

A (tD) is FID amplitude at given time tD (corresponds to Mz (t) 

One can calculate T1 from the slope of a plot of ln(A0 – A (tD)) versus tD. 

To have quick but reasonable estimation of T1 find that when magnetization reaches 
zero A(tD)=0 from Eq.  10 we have: 
 

⋅=⋅=  Eq.  11

Thus one can find T1 easily from tD delay that produces zero FID signal after second 
(Π/2)x pulse (T1=TD/0.69). 

Inversion-recovery sequence and the net magnetization dynamics for several interpulse 
delays are shown in Figure 30. 
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Figure 30. Inversion-recovery sequence and net magnetization dynamics for different 
interpulse delays tD. 
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3.1.3 Saturation Recovery method 
The Inversion Recovery method requires a long delay between applying consecutive 
sequences to allow complete relaxation of spins after the second Π/2 pulse. This makes 
the IR method more time consuming for samples characterized by long T1 times. The 
Saturation Recovery (SR) method eliminates the need for a long delay by applying a 
train of Π/2 pulses separated by time τ at the beginning of the sequence. The train of 
Π/2 pulses will quickly destroy any macroscopic magnetization and dynamic equilibrium 
state will be reached between the spins excitation and relaxation quickly. When pulses 
stop, spins relax undisturbed and the magnetization along z-axis builds again. The 
recovery process due to T1 relaxation from saturation can by monitored by applying the 
sampling pulse Π/2 after the tD delay.  

tD

 saturation 
N x Π/2

sampling  
/2Π

recovery

τ τ

Figure 31. Saturation Recovery method. 

The Bloch equation for the Saturation Recovery can be solved now with new beginning 
conditions Mz (0)=0 (note that for IR Mz(0)=-M0): 

 Eq.  12))
T
texp(- - (1M   (t)M
1

0z =

Or in more practical version: 

t
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1-ln  against t=tD returns Plotting semilogarithimic graph of .  
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3.2 Experimental 

3.2.1 Measuring T1 by Inversion Recovery method in distilled water, ethanol, 
water doped with CuSO4, glycerin and rubber  

Directions on the Setup page 
• Start measurements with a glycerin sample. After acquiring satisfactory 

results continue experiment with rest of samples. 
• Activate data acquisition only in one channel (real I or imaginary Q). 
• Use 1P_X sequence to obtain on-resonance FID (follow directions in 

chapter 2.2.1). 
• Set the data acquisition time to cover entire FID (1024 µs recommended). 
• Determine and record the time of Π/2 and Π pulses, 
• Set the proper Receiver Gain, Phase and DC level.  

With good magnet homogeneity the on-resonance FID signal from glycerin 
will decay exponentially into noise after about 5 ms. Figure 32 illustrates 
typical experimental setup. 

 

Figure 32. Setup page during preparation of T1 measurements by Inversion Recovery 
method. Before going to Acquisition page switch data acquisition triggering 
Programmer>Trig from P1 (after 1st pulse) to P2 (after 2nd pulse). 

• In Programmer click Method and select 2P_X_VD, which is a two-pulse 
method that uses a list of variable time delays in the pre-prepared file. 

• Modify sequence parameters:  



PS-15 experimental manual   Page 49   

 1st pulse=Π (If you do not know it start assuming that this pulse is twice 
as long as the earlier determined Π/2. Adjust Π precisely later. 

 Delay time 5 ms; not critical as it will be ignored later during data 
acquisition to file when delay times from prepared list are in use. 

 2nd pulse=Π/2.  
 Repetition time TR=1s, (generally repetition should be five times longer 

than expected T1). 

&  Very important! To store recovering FID trigger data 
acquisition (Trig) after 2nd pulse (P2).  

If properly adjusted there will be no signal after first Π pulse and strong FID after second 
Π/2 sampling pulse. In Figure 32, which illustrates the IR experiment in glycerin, the 
residual FID after the first pulse is due to inaccuracy of Π pulse.  

Directions on the Acquisition page 
• In bottom right dialog window: 

 Type file name. 
 Type number of accumulations. 
 Type comment. 
 Select variable time delay file. If necessary modify time list. 

• Start acquiring data . Check on the bottom window if delay times 
are long enough to reach equilibrium range. You need 3-4 points from this 
area for M0 determination used later in T1 calculations. Change timing or 
add few more points if necessary. 

• Before leaving Acquisition page check bottom status line to assure that 
data was stored in a declared file.  

Repeat measurements of all samples. After placing a new sample into the holder do 
again all adjustments on the Setup page and complete with data acquisition on the 
Acquisition page. More than likely you will change only the receiver Gain, repetition 
time TR, number of accumulations and file with list of pulse delays. Figure 36 through 
Figure 40 may help you in experimental preparation.  

Long spin-lattice relaxation time in distilled water presents an interesting challenge. 
Complete measurement requires a relatively long time to conduct but illustrates nicely 
the importance of long time separation to see the complete recovery of spins after the Π 
pulse. In Figure 35 magnetization still points toward –B0 axis when 100ms after 
inversion sampling Π/2 pulse was applied. In Figure 34 magnetization fully recovered 
when was sampled by Π/2 pulse after 32 s delay! 
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Figure 33. Acquiring data by Inversion Recovery method.  Note that amplitudes of 
extracted points increase monotonically from negative to positive values and reach 
asymptote when nuclear spins completely recover. 

Directions on the Data processing page 
On the Processing page you can process relaxation data using the Inversion Recovery 
calculation routine. You can also extract data points and export as text for further 
calculations using any software you prefer (Excel, Origin, Mathematica, etc). 

• Load data. 
• Set Mark to lock data marker on the beginning of FID. 
• Extract data points. Extracted data points appear on the bottom window. 
• Execute T1 by IR routine, that calculates T1 by linear regression. 
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Figure 35. Negative FID from magnetization in water 100 ms after the inversing pulse. 

 

Figure 34. Positive FID from recovering magnetization in water 32s after the inversing 
pulse. 
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Figure 36. T1 measurements by IR method in distilled water. 

 

Figure 37. T1 measurements by IR method in ethanol. 
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Figure 38. T1 measurements by IR method in distilled water doped with CuSO4. 

 

Figure 39. T1 measurements by IR method in glycerin. 



PS-15 experimental manual   Page 54   

 

Figure 40. T1 measurements by IR method in rubber. 

Summary of T1 measurements by Inversion Recovery. 
Spin lattice relaxation times display huge variety of magnitudes. In afore conducted 
experiments distilled water has the longer T1. Addition of small amount of paramagnetic 
ions (for instance cupric sulfate CuSO4) dramatically shortens T1 in water from 3 s to 
about 100ms. Rubber (Buna) that by definition contains many impurities leads the pack 
with shortest T1. 

Substance T1 [ms]

distilled water 3,000 

ethanol 2,300 

distilled water doped with CuSO4 123 

glycerin 47 

rubber 35 

Table 3. Spin lattice relaxation times of different substances measured by Inversion 
Recovery method. 
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3.2.2 T1 in distilled water by Saturation Recovery method 
Object 
To compare the accuracy and measurement time of Inversion Recovery and Saturation 
Recovery methods in determination of very long spin-lattice relaxation times T1.  

Directions 
• For comparison use distilled water sample. Its T1 relaxation time reaches 

the range of several seconds. Be advised that T1 strongly depends on the 
purity of the water and may vary from source to source. 

• Prepare experimental Setup for on-resonance, one-pulse experiment with 
glycerin sample. 

• Replace glycerin with distilled water sample. 
• Call Saturation Recovery method (Sat) . 
• Set long delay time between saturation and sampling: TD =32s. 
• Adjust Receiver Gain to see unclipped signal as shown in Figure 41. 

Compare it to FID in Figure 34. 

 

Figure 41. Saturation Recovery in distilled water with long delay time TD=32s. 

• Adjust DC level to compensate DC offset. 
• Change delay time to very short TD=100ms. 
• If applied pulses are exactly or very close to Π/2 you should see a straight 

line along zero after sampling Π/2 pulse, that now monitors perfect spin 
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saturation. If positive or negative FID signal appears change pulse length 
and its power. You can see this case in Figure 42. For longer delay times 
magnetization recovers and FID reaches its positive image from Figure 
41.  

• On Acquisition page acquire experimental data into the file with proper 
time delay list (T1 dist water.ttb) and at with least 4 accumulations. 

• On Processing page extract experimental points and calculate T1 by 
using Sat routine. 

 

Figure 42. Saturation Recovery sequence with short delay time TD=100ms. Π/2 pulse 
was slightly adjusted by adding 0.5dB attenuation and almost perfect saturation of 
resonance signal was achieved. 

 
Results summary 
Table 4 shows summary of T1 measurements Saturation Recovery and Inversion 
Recovery methods in distilled water. Both methods deliver close times above 3 
seconds. Saturation Recovery gives slightly more accurate results and in much shorter 
time than Inversion Recovery does (8’22”s and 17’58”, respectively.  
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Method T1 Standard 
deviation 

TR Time of  
4 accumulations 

Inversion Recovery 3.10s 0.07s 10s 1077.5s 

Saturation Recovery 3.39s 0.03s 1s 501.5s 

Table 4. Comparison of T1 measurements in distilled water by Inversion Recovery and 
Saturation Recovery methods. 
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444   NUCLEAR SPIN-SPIN T2 RELAXATION 
MEASUREMENTS. 

4.1 Theory 

Spin-spin relaxation time describes processes that are responsible for bringing nuclear 
spins to an equilibrium state with each other after being exciting by an RF pulse. Due to 
this process spins loose their coherence and as a consequence the dephase of the 
movement of nuclear spins takes place. 

The analysis of the magnetization vector placed in the static field B0 and the RF field B1 
shows that the absorption component of the solution represents a Lorentzian line 
centered at f0. The half intensity of this line is given by Eq.  14. 

2
1/2 ΠT

1f =

exp
2/1f

*
2

 Eq.  14

Assuming perfect magnetic field homogeneity T2 can be simply determined by 
measurements of signal width at half maximum of the spectrum or shortly SWHM.  

In a real experiment, however, the sample experiences a variety of magnetic field 
magnitudes due to imperfections in the magnet called inhomogeneity.  Magnet 
inhomogeneity slightly affects the local resonance frequency of nuclei and as a 
consequence changes the spectrum width. This new experimental line width  
corresponds to the effective spin-spin relaxation time called T  (tee-two-star). 

 Eq.  15
*
2
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One can separate contributions originating from natural line width and from magnetic 
field inhomogeneity: 

 Eq.  16
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Hahn’s two-pulse [(Π/2)x - tD - Πx] spin-echo method circumvents the magnetic field 
inhomogeneity problem. As magnetization decreases between pulses because of 
natural transverse relaxation process, spin-echo signal decays too. Thus one can 
calculate T2 from the plot of the echo amplitude A(tD) as a function of tD (Eq.  17). 

 
Eq.  17
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T
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There are two other more popular methods that eliminate the instrumental (or 
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inhomogeneous) contribution, Carr-Purcell and Carr-Purcell-Meiboom-Gill methods. 
Both methods are based on the fact that dephasing of nuclear spins due to magnetic 
field inhomogeneity is reversible under certain conditions allowing the measurement of 
intrinsic spin-spin T2 relaxation time. 

4.1.1 The Carr Purcell (CP) method 
The Carr-Purcell sequence used for T2 measurements consists of a single (Π/2)X pulse 
followed by a train of ΠX pulses.  The  (Π/2)X pulse rotates the Mz magnetization toward 
the +Y’ axis. ΠX pulses that appear in the same time intervals flip decaying My 
magnetization between -Y to +Y generating consecutive spin echoes.  

If RF pulses are separated by a period of time 2τ as shown in Figure 43 and spin 
diffusion is absent (this for teaching purposes can be controlled by selecting proper 
samples) the absolute amplitude of the echoes decay exponentially as: 

 Eq.  18)]/2(exp[ 2TNAN τ−≈

-where a AN is a number of echo under consideration. 

 

(Π/2)X ΠXΠXΠXΠXΠXΠXΠX

τ

ΠX

2τ 2τ 2τ 2τ 2τ 2τ 2τ
RF
pulses

Spin
response

 

Figure 43. Train of (Π/2)X and ΠX and pulses and corresponding echoes in CP method. 
Note that echoes appear at 2τ, 4τ, 6τ,..., 2Nτ. Odd-echoes are negative whereas 
even-echoes are positive. 

4.1.2 The Carr-Purcell-Meiboom-Gill (CPMG) 
The Carr-Purcell method suffers from possible cumulative errors that originate from the 
inaccuracy of adjustment of the Πx pulse length. Meiboom and Gill modified CP 
sequence changing the phase of Π pulses by 90o.  In the language of the “rotating 
frame” changing phase of the RF pulse by 90o corresponds to applying it along Y’ axis. 
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Now ΠY pulses move magnetization around the Y’ axis. If the pulse is exactly 180o then 
echoes are formed in X’Y’ along Y’ axis. If the pulse is (Π -/+ε)Y refocusing of odd-
echoes takes place somewhere in the plane above/below X’Y’ plane, whereas 
refocusing of even-echoes appears in exactly X’Y’ plane. Thus all odd-echoes are 
slightly smaller and even-echoes are of correct amplitude (see more detailed analysis in 
Figure 5). If spin diffusion contributions are neglected, amplitudes of echoes decay 
exponentially with time constant T2.  

 

(Π/2)X ΠYΠYΠYΠYΠYΠYΠY ΠY

τ 2τ 2τ 2τ 2τ 2τ 2τ 2τ
RF
pulses

Spin
response  

Figure 44. (Π/2)X and ΠY and corresponding echoes in CPMG method. Note that all 
echoes are positive and that first echo is slightly smaller than 2nd due to slight 
inaccuracy of ΠY pulse setting. 
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4.2 Experimental 

Object 
To compare T2 measurements in glycerin using different methods: 

• From spectrum line width,  
• Manually using Hahn’s spin echo. 
• Using Carr Purcell method. 
• Using Carr Purcell Meiboom Gill method. 

 
4.2.1 Estimating T  from spectrum line width. *

2

Comment 
This is a quick method to estimate spin-spin relaxation time from the NMR spectrum. It 
requires only acquisition of free induction decay and FFT on this signal. 

Directions 
• On the Setup page prepare off-resonance FID in I and Q channels as 

described in 2.2.4 or follow screen capture in Figure 45. 

 

Figure 45. Experimental setup to acquire FID for line width determination. 
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• On the Acquisition page set accumulation number (Acc) to 16 to get a 
good SNR and save the FID to the file. 

• On the Processing page load experimental data from file and do FFT. 
• With data processing tools correct the spectrum phase, expand it 

horizontally and vertically, and determine line width on half maximum. 

• Calculate *T  time from 2 exp
1/2

*
2 Πf

1
=T  (or see Eq.  16). 

 

Figure 46. Measuring line width on Processing page using line width LW tool. 
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4.2.2 Measuring T2 time manually using simple spin-echo method 
{(Π/2)X - τ - ΠX} 

Comment 
T2 times can be simply calculated from echo amplitudes that decrease exponentially as 
a time delay between pulses increases. Experiment will be performed on Setup page 
only. Amplitudes of spin-echo signal as function of time delay will be measured and later 
processed manually or with any independent software (Excel, Origin, etc). 

Directions 
• Prepare on-resonance spin-echo experiment (use 2P_X_D sequence) 

with one channel active. 
• Set time delay between pulses to a minimum to see very strong 

undisturbed echo. 
• Set triggering of the acquisition after ΠX pulse: Programmer>Trig>P2  

 

Figure 47. Measuring spin echo amplitude versus different interpulse delays for T2 
calculation. 

• Set data marker on the echo center, record time and amplitude. 
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• Change time delay to see echo decaying in the noise, record time. If echo 
disappears from acquisition range change Dwell Time accordingly. 

• Divide time of disappearing echo into 16-25 intervals and make list of time 
delays. 

• Select time delay from a list and measure corresponding echo amplitude. 
To improve SNR start measurements with several accumulations (16 are 
usually enough) 

• Calculate T2 from echoes amplitude decay manually using Eq.  17 or fit 
with any program. Figure 48 shows results of experimental data fit to 
one-exponential decay function using Origin program. 
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Figure 48. Fit of experimental data to one-exponential decay function 
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PS-15 experimental manual   Page 66   

4.2.3 Determining T2 in glycerin by Carr-Purcell method 
{Π/2)X - τ - [ΠX - 2τ - ΠX ...]xN} 

Comment 
By rapidly acquiring a series of echoes at different delay times in a single sequence the 
Carr-Purcell method reduces the spin diffusion effect on the measurement of T2. 

Directions 
• Establish on-resonance conditions with one-pulse sequence. 
• Determine length of Π/2 and Π pulses. 
• Call CP25 method. It automatically generates Carr-Purcell sequence with 

25 echoes. 
• At Setup page adjust Π/2 and Π pulses (length and power) to see several 

echoes. 

 

Figure 49. Setup for CP experiment in glycerin. 

• On Acquisition page save the data to file with at least 16 accumulations.  
• On Processing page: 

 Mark a last echo that is visible from noise 
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 Extract echoes coordinates 
 Perform T2 calculation by CP method. 

 

Figure 50. Processing CP data. 
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4.2.4 Determining T2 in glycerin by Carr-Purcell-Meiboom-Gill method  
{Π/2)X - τ - [ΠY- 2τ - ΠY ...]xN} 

Comment 
CPMG method is a modification of CP method that shifts the phase of Π relative to the 
initial Π/2 pulse by 90o to compensate for the error of Π pulse setting. 

Directions 
• Establish on-resonance conditions and determine length of Π/2 and Π 

pulses. 
• Load CPMG25 that produces 25 consecutive spin echoes. 
• Select proper delay time to see echoes not overlapping on each other. 
• Select Receiver Gain to obtain strong echoes without signal clipping. 
• Select Dwell Time to cover time of all 25 echoes. 

 

Figure 51. Setup for CPMG experiment in glycerin. 

• On Acquisition page select at least 16 accumulations and save data to 
file.  

• On Processing page: 
 Mark a last echo that is visible from noise 
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 Extract echoes coordinates 
 Perform T2 calculations by CPMG method. 

 

Figure 52. Processing CPMG data. 

4.2.5 Summary of T2 measurements 

Method of measurement T2 [ms] Standard deviation [ms] 

Line width 0.9  

Hahn spin-echo 21.4  

CP 29.2 4.0 

CPMG 67.1 0.7 

Table 5. Summary of spin-spin relaxation time measurements in glycerin, using different 
methods. T2 from the line width is dramatically short due to strong inhomogeneous line 
broadening. 
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555   INSTRUMENTATION 

5.1 Mapping the probehead RF coil 

Introduction 
To observe nuclear magnetic resonance phenomenon, the nuclei precessing around 
constant magnetic field B0 must be exposed on the radio frequency field B1 that rotates 
in the plane perpendicular to the B0 field.  This rotating field, or circularly polarized field, 
of magnitude B1 can be obtained from the decomposition of a linearly oscillating field 
(linearly polarized) of magnitude 2B1 (Figure 53). Only the field component that rotates 
in coherence with the precessing nuclear magnetization is used. The other one is 
radiated in space and lost. 

B cos( t)1 ω

B cos(- t)1 ω

2B cos( t)1 ω  

Figure 53. Decomposition of linearly polarized field into two circular fields. 

In experimental practice the linearly polarized B1 field can be easily produced by a 
single closed loop driven by source of high frequency electromotive force.  

~

B1

a) b)

EMF

 

Figure 54. Single loop driven by a source of Electromotive Force (a) and solenoid b) as 
a source of linearly polarized field B1. 
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Homogeneity of a B1 field generated by a single loop is rather poor. It can by improved 
by combining a series of single loops into a solenoid (Figure 54). The solenoid 
incorporated into the probehead resonance circuit is the most popular kind of 
transmit/receive antenna used in pulsed NMR spectroscopy.  Its high homogeneity 
remains an important issue in experiments that require precisely defined rotating angles 
(Carr-Purcell). One can address B1 field homogeneity by reducing the sample volume 
but it has its limit due to degradation of S/N ratio. 

Object 
To measure B1 field distribution along the solenoid longitudinal axis (z). 

Instructions 
• Connect experimental setup as shown in Figure 55. 
• Place the pick-up coil in the RF coil center. 
• Load one-pulse 1P_X method and set transmitter attenuation for 12dB, 

pulse width for 50µs and repetition time for 300ms.  

OSCILLOSCOPE

Y- Channel

External
Triggering

PS 15 Unit

Programmer

RF

TTL

RF coilpickup coil

oring

Teflon
support

1 mm-notched plastic tube

1 
m

m

b)

a)

B1

c)

 

Figure 55. Experimental setup to map the B1 intensity inside the RF coil and to monitor 
RF pulses. a) Pick-up coil inside the RF coil, b) pickup coil holder (some holders are 
glass tubing and same are plastic with 1-mm notched outer wall), c) linearly polarized B1 
field within the solenoid. 
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RF coil mapping
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Figure 56. Intensity of signal induced in the pickup coil vs. its position relative to the 
upper edge of probehead sample holder. 

• On the scope panel: 
 Select Trigger source as External. 
 Select Trigger mode as Normal 
 Adjust the Level and Holdoff of the triggering to see stable RF pulse. 
 Adjust vertical gain to see bottom and top part of the pulse 

• Move pickup coil up and down and record the peak-to-peak amplitude of 
the pulse and the corresponding pickup coil position. 

• Repeat measurements until amplitude of the pulse drops to about of 1% of 
peak value. 

• With spreadsheet program (Excel) make plot intensity of RF pulse versus 
pickup coil position, Figure 56. 

• Find the position of the maximum signal and the area of its 10% drop.  
Consider this area as most useful in terms of B1 homogeneity. Mark it on 
the sample positioner and use as reference in your experiments. For fine 
experiments like CP and CPMG try to reduce size of the sample to the 
value you have gotten (3mm in an example). 
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5.2 Watching pulse sequences 

Object 
To see real RF pulses. In particular to check how their shape changes due to different 
RF attenuation, pulse width and delays.  

To watch the automatic change of pulse delay time when executing 2P_X_VD 
sequence during T1 measurements.  

Instructions 
Watching RF pulse 
• Connect experimental setup with pickup coil in the center of RF coil as 

shown in Figure 55. 
• Load any one-pulse method (1P_X). 
• Set pulse time for 50µs and repetition time for 250ms. 
• On the oscilloscope: 

 Select Trigger source as External. 
 Select Trigger mode as Normal. 
 Adjust the Level and Holdoff of the triggering to see stable RF pulse. 
 Adjust vertical gain to see bottom and top part of the pulse.  

• On Setup page change Transmitter>Attenuation from 0dB to 12dB and 
watch the change of RF pulse amplitude (see Figure 57). 

 

Figure 57. Radiofrequency  pulse visible with a pickup coil on an oscilloscope. 
Horizontal scale is 20µs/div, vertical scale is 0.5V/div. 



PS-15 experimental manual   Page 75   

Observing effect of pulse delay during automatic T1 measurements 
• Switch spectrometer Mode of operation to Relaxometry and load 

2P_X_VD sequence.  
• Set both pulses for 50µs2, keep repetition time 250ms and set triggering 

after first pulse (Programmer>Trig 1P). 
• On Acquisition page select variable time delay file t116_r. This file 

contains 16 different delay times (0.3, 0.5, 1, 2,4,8, 16, 32, 50, 75, 100, 
150, 175, 200, 250; all in milliseconds) normally used for T1 relaxation 
times measurements with Inversion Recovery and Saturation Recovery in 
rubber. 

• Start acquiring data on the Acquisition page without typing file name. 
• Watch second pulse moving automatically as program calls consecutive 

delay times. This is real thing that happens during automatic T1 
measurements! 

Diagrams of each pulse sequences are shown graphically on a Setup and 
Processing pages. Pickup coil and scope gives flexible means to see what 
exactly happens inside probehead RF coil.   
During the experiment user can monitor RF sequences continuously without using the 
pickup coil by connecting oscilloscope Y channel to TX 1:10 output on the PS15 
electronic unit rear panel.  
If RF pulses do not produce enough contrast on the oscilloscope screen use TTL 
Programmer output to see pulses envelopes (see Figure 58). 

 

Figure 58. An envelope of the 50µs RF pulse monitored on Programmer output. 

                                            
2 Keep attenuation at 12dB to reduce transmitter power when long RF pulses are 
generated. 
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5.3  Amplitude detector and phase sensitive detector 

Introduction 
During the receiving period the NMR spectrometer records the movement of weak 
magnetization component in the plane perpendicular to the B0 magnetic field.  As this 
component decays due to spin-spin and spin-lattice relaxation the induced signal 
decays too.  

The voltage coming from the RF coil is in the shape of sine wave signal (of precession 
frequency) modulated by the exponentially decaying function (T2, T1). The envelope of 
this signal carries valuable information about precessing nuclei. If treated by Fourier 
transformation the envelope converts to an NMR spectrum. If acquired with different 
time delays, signal envelopes deliver information about relaxation times.  

Extracting the envelope from the radio frequency takes place in the process called 
signal detection.  

5.3.1 Amplitude detector 
The easiest way to obtain the envelope of FID or spin echo is simply by amplifying and 
rectifying the signal induced in the RF coil. This kind of detection is called amplitude 
detection as it is primarily sensitive for signal amplitude, or diode detection as the diode 
is used as detecting device. Diode amplitude detection suffers from the nonlinear 
response of a semiconductor element. 

R R

C

D

 

5.3.2 Phase sensitive detector 
An electronic device called the double-balanced mixer (DBM) offers another means for 
the nuclear signal detection. It has the ability to multiply two sine wave signals that enter 
radio frequency (RF) and local oscillator (LO) inputs.  

Figure 59. Diode D as an amplitude detector with low-pass RC filter for carrier 
frequency removal. 
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Suppose the RF and LO inputs of the DBM are supplied by two sine wave signals: 
SRF=ARF(sinωRFt-φRF) and SLO=ALO(sinωLOt-φLO) of frequencies ωRF and ωLO, 
respectively, ϕRF and ϕLO are arbitrary phase shifts. The double balance mixer performs 
multiplication of both signals: 

  Eq.  19 )sin()sin()( LOLOLORFRFRFLORF tAtASStS ϕωϕω −⋅−=⋅=

Using the trigonometric relation: βαβαβα sinsincoscos)cos( m⋅=±  one can easily 
rewrite the previous equation to: 

 Eq.  20)]}()cos[)](){cos[(
2
1)( LORFLORFLORFLORFLORF ttAAtS ϕϕωωϕϕωω −−+−−−−⋅=

)]}()cos[)] 00 RRR t

In an NMR experiment SRF signal corresponds to a nuclear signal that precessing nuclei 
induce in the probehead coil and SLO signal is the reference signal that comes from the 
same source as the carrier frequency that produces the RF pulses. ARF is a time 
dependent exponential function A(t) that describes nuclear relaxation processes, 
whereas ALO is the amplitude of the reference signal and can be neglected for simplicity 
in further analysis as shown in Eq.  21. This is justified by properties of DBMs that at 
certain levels of the LO signal produce an intermediate frequency signal IF, independent 
of the LO amplitude. 

 Eq.  21(){cos[()()( 00 R ttAtS ϕωω −−⋅= ϕϕωωϕ −−+−−

Figure 60 illustrates the double balanced mixer operation. Similarity of the DBM symbol 
to mathematical symbol ⊗ emphasizes its multiplication property.  

S ( , )RF RF RFω ϕ

S ( , )LO LOω ϕLO

S[( -ωRF ω ϕ ϕLO RF LO), ( - )]

S[( +ωRF ω ϕ ϕLO RF LO), ( - )]
LO

RF

IF

 

Figure 60. Double balanced mixer operation. 
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With proper filtering the high frequency term: )]()cos[ 00 RR t ϕϕωω −−+ can be removed 
and Eq.  21 reduces to a less complex form: 

 Eq.  22)](){cos[()()( 00 RR ttAtS ϕϕωω −−−⋅=

or assuming ϕϕϕ ∆=− )( 0 R

]}){cos[()()( 0

 

 Eq.  23ϕωω ∆−−⋅= ttAtS R

R

Eq.  22 describes general off-resonance conditions when the frequency of precessing 
nuclei differs from reference signal. 

In resonance when ωω =0

]}{cos[)()(

 DBM produces a signal: 

ϕ∆⋅= tAtS  Eq.  24

which describes the FID envelope and depends on the phase difference between the 
NMR signal and the reference signal, thus in this application DBM is called a phase 
sensitive detector.  

The great advantage of the phase detector is: 

• high linearity,  
• suppression of unwanted interferences, 
• sensitivity to differences between the NMR signal and reference signal 

frequency and phase that is of utmost importance in further FFT process. 

Two parallel combined phase sensitive detectors with a 90o phase shift in reference 
channels constitute a quadrature detector, which is the basic device used in FT NMR 
spectroscopy. 

DBM1
I

Q
90

o

0
o

LORF

DBM2  

Figure 61. Quadrature detector created from two double balanced mixers, and 0o-0o and 
0o-90o power splitters. 
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Object 
Comparison of the performance of phase sensitive detector and amplitude detector. 

Instructions 
• Needed:  

 Pick-up coil,  
 Variable attenuator about 0-50dB, 1dB step,  
 RF generator of sine wave signal of 15MHz and about 100mV 

amplitude,  
 Coaxial cable with BNC connectors. 

• Preparation 
 Connect experimental setup as shown in Figure 62. 

RF

probehead
RF coilpickup 

coil

Generator

Attenuator

 

Figure 62. Experimental setup to test spectrometer phase and amplitude detectors. 

 Place pickup coil carefully inside probehead close to the top edge.  
 Set external attenuator for 20dB. 
 Set generator frequency as close as possible of 15 MHz. If there is a 

means of amplitude control, set the amplitude at very low level. 
 Disconnect transmit cable (TX) from the probehead, turn on the 
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spectrometer and start the control program in Spectrometer lock-off, 
Spectroscopy mode.  

 Execute any of one-pulse sequences (1P_X recommended).  

• Testing the phase detector 
 Switch Receiver detector to Phase detector. 
 Set Receiver>Gain to typical value used in one-pulse experiments 

with glycerin or water (usually around 20). 
 Adjust the position of the pick-up coil and generator amplitude to have 

signal covering the whole range of the ADC converter (full data 
window). If necessary increase or decrease attenuation of the external 
attenuator. Have room for an extra 25dB to conduct measurements. 

 Adjust generator frequency, and dwell time to see several periods of 
detected signal.   

 Using horizontal marker conduct measurements of signal amplitude - 
see Figure 63. 

 

 Repeat measurements increasing attenuation to obtain 20-25 data 
points. 

• Testing amplitude detector. 
 Switch Receiver detector to Amplitude detector. 
 Change the attenuation of an external generator to see the detected 

signal as a straight line reaching maximum on the data display. Unlike 
the phase detector the amplitude detector does not sense the 
frequency difference between generator frequency and spectrometer 
operating frequency, but responds only to the amplitude change. 

Figure 63. Measurement of the detected signal produced from phase detector. To 
increase the measurement dynamic (and accuracy) measure peak-to-peak value rather 
than peak. 

 Using horizontal marker perform measurements of signal amplitude for 
different attenuation. 
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Figure 64. Signal amplitude measurements with the amplitude detector. 

Results 
To display acquired amplitudes as a function of the signal intensity at the detectors input 
first we have to transform a logarithmic scale of dBms to a linear scale of amplitudes. 
From the definition K[dBm]=20log(A), where attenuation K is in [dBm] and A is the 
ratio of signal amplitudes we have an equation that expresses the signal input in signal 
attenuation units A=10K/20. For each attenuation value K calculate the corresponding A 
and display the signal output amplitude against A. 
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Figure 65. Response of spectrometer phase detector to the linear signal. 
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Figure 66. Response of spectrometer amplitude detector to linear signal. 

Figure 65 and Figure 66 present responses of phase and amplitude detectors to linear 
signal. Response of phase detector is very linear from zero, whereas amplitude detector 
displays non-linearity for signals above 400mV. Amplitude detector is almost non-
responding to signals below 50mV. 
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5.4 “Magic cable” or properties of lambda-
quarter cable 

5.4.1 Introduction 
The PS 15, as with many other contemporary pulsed NMR 
spectrometers, uses a single resonance circuit for 
generating an oscillating B1 field and for the reception of the 
precessing nuclear signal.  

Transmit (TX) 
The oscillating B1 field is produced by a high frequency 
electric current that runs through the resonance circuit 
solenoid during the transmit period (Figure 67). The source 
of the current is a power amplifier (sometimes called the 
transmitter to show the analogy to broadcasting) which is 
capable of amplifying microsecond pulses to several 
thousands watts of power. The small volume, highly efficient 
resonance circuit of the PS15 spectrometer requires much 
less power. Only 2-3µs pulses of 20 watts peak power is 
enough to generate a Π/2 pulse that translates to 
60Vpeak-to-peak at 50Ω load.  

T/R
TX

Receive (RX) 
During the receive or detection period that follows the RF 
pulse, precessing spins induce a very weak nuclear signal in 
the solenoid (about 10µV). This signal is first amplified by a 
low noise preamplifier before reaching the receiver and 
detector. 

Figure 67. T/R switch 
during the transmit 
period TX. 

Transmit/Receive switch 
There is a conflict of applying power pulses from the 
transmitter to the resonance circuit and the simultaneous 
protection of the sensitive preamplifier connected to the 
same resonator. An electronic device called a multiplexer or 
transmit/receive switch (T/R) switches the resonance circuit 
between the transmitter and the preamplifier. The multiplexer 
must operate at a high frequency, switch very fast, last high 
power of RF pulses and not introduce any losses or 
distortion to the nuclear signal.  

T/R
RX

λ/4 cable and crossed diodes properties 
The PS15 multiplexer design based on the impedance 
transforming properties of the coaxial cable of a length 
corresponding to 1/4 of the electromagnetic wave length λ 
(1/4λ) at the frequency of interest and of the nonlinear 

Figure 68. T/R switch 
during the receiving 
period RX. 
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properties of crossed semiconductor diodes connected 
antiparallel. 

Generally for a coaxial cable length of any odd number of 

quarters of wavelength, λ⋅
−

4
12n , the input impedance of the 

cable is described by the formula: 

 
Eq.  25 

L
IN Z

ZZ
2
0=

When grounded on one end (Zout=0) the cable shows 
infinite input impedance.  

The input impedance of the unloaded cable drops to zero.  

After loading the cable with an impedance of ZIN=Z0 the input 
impedance becomes the cable’s characteristic impedance 
Z0. 

λ/4

Z =0in Z = L

The wavelength of an electromagnetic wave in vacuum is 

given by 
f
c

=λ ; where c is speed of light in a vacuum, and f 

is the electromagnetic wave frequency. Assuming 
c=3x109 m/s and f=15x106 Hz (15MHz) we can estimate the 
lambda quarter length as 5 m. In a coaxial cable, however, 
there is no vacuum but there is the dielectric isolator so the 
speed of the electromagnetic wave is much slower than 
3x109 m/s, thus λ/4 is considerably shorter. With an 
RG-174/U coaxial cable a quarter lambda line is about 
3.3 meters. 

Due to their strong nonlinear voltage-current dependence, a 
semiconductor diode shows high impedance properties for 
low voltages, and low impedance properties for high 
voltages. Therefore diodes operate like a switch which is 
open for large signals and closed for small signals. Two 
antiparallel connected crossed diodes combine these 
properties for positive as well for negative voltages and can 
operate also as the aforementioned switch for an alternating 
signal. For silicon diodes this switching point is around 0.7 V. 

impedance

+0.7V-0.7V voltage
accross 
diodes
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T/R switch operation 
If combined together a λ/4 cable and two sets of crossed 
semiconductor diodes (Figure 69) will work as a tricky 
transmit/receive switch described below.  

 
Transmit period: 

• Both crossed diodes D1 and D2 conduct during RF 
power pulses (high voltage opens diodes). As a 
consequence the transmitter is connected to the 
resonance circuit while the preamplifier is 
disconnected from the dangerously overloaded 
resonance circuit. 

Receive period: 
• Immediately after the RF pulse is turned off, the 

impedance of diodes D1 and D2 increase (the low 
voltage case where diodes do not conduct). This 
closes the path through the D1 diodes from the 
transmitter to the resonance circuit isolating it from 
the noise coming from the transmitter’s direction. 
Meanwhile the high impedance of diodes D2 opens 
the λ/4 coax cable and connects the resonator to 
the preamplifier. 

5.4.2 Experimental 
Object 
To show “magic” properties of the λ/4 cable we will conduct 
a simple experiment by connecting the cable to the output of 

Figure 69. Passive T/R switch. 

P

D1
 

D2

λ/4 to 
Receiver

from
Transmitter
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the preamplifier and shorten and un-shorten the cable with a 
piece of wire while observing the FID signal on the data 
display. 

Needed: 
• λ/4 cable, 
• BNC jack to shorten cable to the ground, 
• BNC T adapter. 

Instructions 
• Plug a BNC T-type adapter between the 

probehead RX output (this is a preamplifier 
output) and the unit RX input (this is receiver 
input). 

• On the Setup page prepare a one-pulse 
experiment with the glycerin sample. 

• Connect opened λ/4 to the T adapter. Note the 
drop of signal on the Setup data window 

• Now shorten the coax cable output with the 
BNC jack or a piece of wire and pair of 
crocodile clips to ground. Note signal recovery 
on the Setup data window. 

Conclusion 
As you see one can not apply common sense to results 
obtained with a λ/4 cable operating at 15MHz. Under certain 
conditions the coaxial cable works as an unique impedance 
transformer that transforms a low load impedance to a high 
input impedance (or high load to low input impedance). 
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5.4.3 More experiments with λ/4. 
If you have a signal generator (G) and an oscilloscope  (Osc) 
available in your laboratory you can make a more systematic 
study of λ/4 cable properties. Connect an experimental setup 
as shown and change the frequency of the generator with 
the λ/4 shorted to ground. Look for the maximum of the 
signal at 15 MHz. Now open the cable, change the 
frequency and observe the minimum of the signal at 15 MHz. 
Compare your observations to Eq.  25. 

G

Osc

T

λ/4

Connect an additional piece of coax cable through the BNC 
barrel adapter and look at the shift of frequency of the 
maximum/minimum signal toward lower frequencies.  

You can replace the oscilloscope and generator with more 
advanced device like a network analyzer and have the cable 
frequency characteristics in a matter of seconds. Figure 71 
and Figure 72 show reflected power from shorted to 
ground and open λ/4 15 MHz cable, respectively, obtained 
with Agilent (formerly Hewlett Packard) network analyzer. 
Note that positions of minimums and maximums fit to these 
predicted by Eq.  25 

 

Figure 70. 
Experimental setup to 
study λ/4 cable 
frequency properties. 
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Figure 71. Reflected power from λ/4 15 MHz cable shorted to ground.  

 

 

Figure 72. Reflected power from l/4 15 MHz open cable. 
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5.5 Measurements of a static magnetic field with a tesla meter (Smart 
Magnetic Sensor) 

5.5.1 Introduction 
An electric current flowing through a conductor located in a magnetic field experiences a 
transverse force called the Lorentz FL magnetic force. This force is defined as a vector 
product: 

Θ=×= sinqvBBvqFL

rrr

Θ

 Eq.  26

q - carrier charge 
v - velocity of the carrier 
B - magnetic induction 

- angle between vectors v and B 

VH

VB
I

B
FL

Eq.  26 implies the following: 

Figure 73. Lorentz force and separation of flowing electric charge (+/-) by an external 
magnetic field B.  

a) The magnetic force is perpendicular to both the current I and the magnetic field B 
b) The magnitude of the magnetic force FL is zero when charges move parallel to 

the magnetic field (or when the charges are stationary) and reaches a maximum 
±(qvB) when the charges move perpendicular to the magnetic field 

c) Direction of the force can be determined by the “right hand” rule 
The Lorentz magnetic force separates moving charge carriers (Figure 73). The 
separation effect was named Hall effect after E.H. Hall who discovered it in 1879.  The 
charge separation produces transverse voltage between two sides of the conductor that 
is linearly proportional to the magnetic field B and is used to measure magnetic field. 
TEL-Atomic Inc., introduces a new pocket-sized Tesla Meter Model 2000 equipped with 
Hall probes that cover the measurements of a magnetic field in the range of 0.01 to 
1999 mT. This tesla meter can be used in a series of experiments with a PS15 
electromagnet to measure the magnetic field inside and outside the magnet and to 
illustrate properties of the Hall effect magnetic sensors. 
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5.5.2 Experiment preparation 
Before starting experiments prepare the spectrometer electromagnet and tesla meter 
probe. 

1. For all measurements use the tesla 
meter axial probe type SMS102. Since 
the axial probe is too big to fit in a 
NMR probehead, the probehead 
should be removed to give free access 
to the space between electromagnet 
poles. 

To do this, turn off the unit and unscrew 
the two locking screws from magnet (but 
do not disconnect any cable) and lay the 
probehead flat on a table (see Figure 74). 
Now turn on the NMR spectrometer, but 
do not start the control program. With the 
NMR probehead removed and the control 
program not running, the electromagnet 
coils are driven only by the current from a 
regular power supply and neither flux nor 
NMR-lock field stabilizer is active. 
Nevertheless precision of the 
spectrometer current stabilizer is 
sufficient for stable indications of the 
tesla meter’s last digit. 
 
2. Wrap the tesla meter sensor in the middle 2-3 times with ¼” paper tape ( see 

Figure 75). 
3. Cut a 1” diameter disc from cardboard 1/8” thick.  
4. With a sharp blade cut a rectangular shape in the 

center that will fit the tesla meter probe. Draw an arrow 
extending from the probe. 

5. Slide the tesla meter probe in the slot. The arrow will be 
useful in angle measurements while the edge of the 
paper tape gives a convenient reference in magnetic 
field mapping. 

 
 
 

Figure 74. Electromagnet, detached NMR 
probehead and the tesla meter. 

Figure 75. Probe and disc assembly. 
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5.5.3 Angle dependence of the Hall sensor readings 
Generally a magnetic field is a three dimensional vector. A one-axial probe detects Hall 
voltage only in one direction and as a consequence measures ONLY one component of 
the magnetic field. Measuring the magnitude of this component depends on the 
orientation of the probe with regards to magnetic the field. 
TEL-Atomic’s 2000 Tesla Meter Probe is essentially the substance that displays a 
strong Hall effect. As a consequence it shows an angle dependence between the 
orientation of a magnetic field and the direction of the charge current I. From Eq.  26 
one can expect zero charge separation and zero Hall voltage when B is parallel to v (or 
I), and maximum indications when B is perpendicular to v.  
The purpose to this experiment is to the find main axis of the tesla meter probe. Proper 
measurement of the magnetic field magnitude requires perpendicular orientation of this 
axis to the magnetic field. 

1. Insert the tesla meter sensor in the slot on the top of the magnet (Figure 76) 
2. Measure magnetic field in the current sensor position 
3. Rotate sensor and repeat measurements every 20-30 rotations 
4. Make a plot of the  tesla meter readings B versus the angle  Θ

Θ5. Try to fit the B = f( ) plot to Eq.  26 . In the Figure 77 black circles show 
experimental points while the red line is the fit. 

6. For further considerations take into account that the PS15 electromagnet field 
is oriented along poles’ axis (90o-270o)  

 

Figure 77. Angle dependence of tesla 
meter readings (black circles) and data fit 
to sinΘ function (red line). 
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Figure 76. Tesla meter probe and the 
hand made disc assembly on the 
magnet’s dial.   
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5.5.4 Mapping magnetic field 
The magnetic field is confined mostly between the electromagnet’s poles. The tesla 
meter provides a convenient way to map the field i.e. to produce 1- or 2-dimensional 
pictures showing the spatial 
distribution of the magnetic 
field.  
Mapping requires 
knowledge of the magnetic 
sensor position and 
magnetic field amplitude. In 
1-dimensional mapping the 
distance from a fixed point 
of reference is needed. In 
Figure 78 the magnetic 
sensor is placed in the 
magnet’s center and then 
moved vertically such that 
the magnetic field can be 
recorded every 5 mm of 
displacement.  

A 2-dimensional mapping 
presents a certain challenge 
but can be overcome with 
some ingenuity of the experimenting person.     
 

5.5.5 Measuring magnetic field remanence 
A magnetic field in an electromagnet is produced by a 
direct current that flows through its coils. The amount of 
magnetization the electromagnet retains at zero driving 
current (field) is called remanence. It must be driven 
back to zero by a current (field) in the opposite 
direction. 
One can see remanence of the PS15 magnet in the 
following experiment. 
With the console off (no current) insert the tesla 
meter probe between poles. While rotating the 
probe measure the magnetic field amplitude. 
Usually remanence varies between 2-5 mT. Note 
that the magnitude of the Earth’s magnetic field is an order lower (around 0.05mT) and 
cannot significantly contribute to the measurement. 

 

Figure 78. Electromagnet’s one-dimensional field map. 

Figure 79. Remanence field on the 
hysteresis curve. 
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666   TOWARDS MORE DIFFICULT  EXPERIMENTS 

6.1 Angle dependence of spectra shape in the gypsum monocrystal 

6.1.1 Introduction 
It has been seen from the study of oriented crystals, that 1H NMR spectra of solid 
samples can give structural information that X-ray crystallography cannot deliver due to 
poor X-ray scattering on the hydrogen single electron.  

 

Figure 80. Large gypsum monocrystal. Note high transparency with slightly yellow 
edges. Long diagonal is about 40 mm. 

This observation was first published by G. E. Pake in the early years of NMR3. He 
observed the splitting of the NMR line from water protons in a hydrated gypsum 
(CaSO4•H2O) monocrystal (Figure 80) and powdered samples. The splitting originates 
from the interacting of magnetic dipoles µ in a static magnetic field B0. In crystalline 
solids these interactions produce an additional local magnetic field Bloc which 
contributes to the effective magnetic field acting on each spin. In less rigid substances, 
(mostly gases and liquids) fast molecular motion averages this local magnetic field to 
zero. 

Since dipole-dipole interactions decrease as the inverse cube of the dipoles distance, 
nuclear moments of protons in water molecules of hydrations are predominantly in the 
local field of its neighbor. Thus protons in water (spin ½) can achieve two positions with 
regard to the static magnetic field B0. Some spins will be located in higher fields (when 
the neighboring spin is parallel to B0) and some will be in lower fields (when the 
                                            
3 G.E. Pake, The Journal of Chemical Physics vol.16, p. 327-336, 1948, “Nuclear 
Resonance Absorption in Hydrated Crystals: Fine Structure of the Proton Line” 
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neighboring spin is anti-parallel to B0). In this simplified model, two NMR lines appear 
symmetrically located along the resonance at B0.  

Of the hydrous sulphates, hydrous calcium sulphate, of the chemical formula 
CaSO4•H2Ο, known as gypsum, is the most important. (The average American house 
contains around 5 tons of gypsum construction material!).  

The gypsum structure consists of parallel layers of (SO4)-2 groups bonded to Ca+2. 
Sheets of water molecules separate consecutive layers of strongly bonded ions. The 
bonds between water molecules in neighboring sheets are rather weak causing the 
crystal to break when it is a subjected to stress on a plane parallel to the sheets. This 
property is known as perfect cleavage in the (010) plane. 

One can determine proton-proton distance in a water molecule by Pake’s method, that 
is from the angle dependence of NMR line splitting. Assuming a certain angle of H-O-H 
obtained from crystallographic analysis the value of proton-oxygen distance can be 
calculated (Figure 81).  

H
O

H

108
o1.58A

0.98A  

Figure 81. Atoms distances and angle in a water molecule according to Pake. H-H 
distance of 1.58D was calculated from spectra splitting. H-O distance was calculated 
from assumption of 108o angle of H-O-H bond. 
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6.1.2 Experimental 
Object 
The purpose of this experiment is the observation of the splitting of the NMR line 
originating from water protons located in different local magnetic fields of the gypsum 
monocrystal. This experiment can illustrate high-resolution NMR spectra in solids. 

 

Figure 82. Sample cut from gypsum monocrystal and its orientation with regard to 
external magnetic field B0. 

The sample has a cylindrical form of approximately 5mm diameter and 6mm long. It was 
cut from a large gypsum monocrystal as shown in Figure 82. The long axis of the 
sample is perpendicular to a crystal perfect cleavage (plane (010). 

Directions 
1. Carefully remove the gypsum crystal glued to the 5 mm glass tube from the 

storage box (Figure 83),  

 

Figure 83.  Elements used in the gypsum study. 
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2. Attach the crystal to the goniometer rotating holder. 

a) Slide the O-ring on the glass tube from the end not occupied by the 
crystal.  

b) Using this positioner move the O-ring to its right location. To assure proper 
position of the crystal in the RF coil its center should be L=70 mm from the 
bottom surface of the holder. If necessary to determine sample position 
more accurately measure the distance L by mapping the RF field of the 
probehead coil (see Chapter 5.1) 

c) Slide tube through the center hole in the holder until the O-ring securely 
nests inside as shown in Figure 84. 

3. Insert the sample carefully inside the magnet (see Figure 85). 

 

Figure 84. Gypsum crystal attached to the rotating holder. Distance from the crystal 
center to bottom of the holder (that rests on goniometer dial surface on the magnet) is 
L=70mm. Check this distance after final assembly with a caliper. 
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Figure 85. Gypsum crystal assembly in the magnet. 

4. On the Setup page prepare a simple ONE PULSE experiment using the 1P_X 
method with the acquisition parameters similar to these in Figure 86.  

 

Figure 86. Setup page to acquire FIDs from gypsum crystal. Note that signal is very 
weak and short. Remember to adjust acquisition time and receiver gain accordingly. 
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5. On the Data Acquisition page acquire the signal with at least 128 accumulations 
to improve Signal-to-Noise ratio. 

6. On the Data Processing page perform FFT (Figure 87). If there are points 
affected by “dead time” perform Left Shift (LS) first to remove distorted points. If 
spectra are to noisy multiply exponentially FIDs by 200-400 Hz. 

 

Figure 87. Splitting of the 1H NMR line in gypsum crystal due to the rotation of the 
crystal. Crystal was rotated clockwise along axis perpendicular to perfect cleavage 
plane (010). B0 direction was changing in this plane. 

 
7. Repeat a FID acquisition for different angles to see change of the splitting in the 

spectra. 
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Suggested modifications: 
• Acquire a large gypsum crystal, make another cut and repeat measurements.  

You may purchase gypsum monocrystals from:  
Great South Gems & Minerals 
38 Bond Drive, 
Ellenwood, GA 30294 
1-888-933-4367 
www.greatsouth.net  
• Since cutting gypsum is a difficult task, crush the monocrystal to powder and 

repeat measurements with a polycrystalline sample. 

• Place small amount of dry plaster composition that contains predominately 
gypsum. Acquire FID of dry powder. Than add drop of water and acquire several 
FIDs when mixture hardens. 

 



PS-15 experimental manual   Page 100   

6.2 Rotating frame experiments 

6.2.1 Introduction 

Effective magnetic field in a rotating frame 
The rotating coordinate frame is a convenient reference frame for use in analyzing the 
interaction of the macroscopic nuclear magnetization M0 arising from the polarization of 
individual nuclear spins in the static magnetic field B0 with rotating magnetic field B1. In 
the rotating frame that moves with B1 field, nuclear spins are stationary or in the 
presence of static field inhomegeneity they move very slowly. Since the laws of Physics 
are independent of the reference frame this slow motion of spins in the rotating frame 
implies that the effective magnetic field in the rotating frame must be much smaller than 
in a laboratory frame (or zero when spins do not move at all). 

The transformation from a laboratory to a rotating coordinate frame gives the following 
equation for the effective magnetic field Beff in a rotating frame: 

Whereω  represents a fictitious magnetic field that appears while going from the 
laboratory to the rotating frame. When a rotating frame moves near the Larmor 
frequency of precessing spins 

/γR

00R γBω =≈ω the fictitious field cancels B0 and only B1 
remains to interact with M0. Figure 88 shows the complete vanishing of B0 in a rotating 
frame when ωR=ω0. As a  consequence the entire problem of interaction of M0 with B0 
and B1 in a laboratory frame is conveniently reduced to rotation of magnetization along 
the now static field B1 in the rotating frame in the sense of the nuclear precession.  

B 0

B =Beff 1

ω
0

0
B

R
/

=
=

γ
ω

/γ

1R0eff B/γωBB
rrrr

+−=  Eq.  27 

 

Figure 88. Reducing of effective magnetic field in a rotating coordinate frame when the 
angular frequency of rotation approaches the Larmor frequency. 

In practice the B1 field amplitude can be easily calculated from the measurements of the 
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angular frequency of precession of magnetization ω1 along B1. Since: 

Where Θ is rotation angle, tp is time of rotation that corresponds to the length of the RF 
pulse tp.  

Since for protons the gyromagnetic ratio γ=2.6752 [kg-1sA], therefore one can transform 
Eq.  28 to a simple formula to calculate the  approximate value of B1 in [Gs]4:  
Where tΠ is time of a Π (180o) pulse in microseconds [µs].  

11 Bγω =
Θ

=
pt

Π1 117.2/tB =

 Eq.  28 

 Eq.  29 

The PS15 20W transmitter, (with the combination of the RF coil which is included with 
the system and having dimensions of 10mm long and 5mm wide, and quality factor 
Q≈30), generates tΠ pulse that for protons varies from 5µs to 7µs thus producing a 
maximum B1 field in the range of 23Gs to 17Gs. This is of course an amplitude of one 
rotating component of the B1 field that follows the direction of rotation of nuclear spins. 

“Spin-locking” and relaxation in the rotating frame. 
The rotating frame is  not only an intellectual vehicle that can be used for a simple 
vector visualization of NMR effect. A drastic reduction of the magnetic field magnitude 
when the rotating frame moves close to a precessing nuclei leads to certain physical 
consequences that can be studied using a series of ingenious experiments.  

• When  0R γB=ω  the radiofrequency field B1 that is constant in the rotating frame 
starts to play the role that B0 plays in laboratory frame. In this  lower field, spins 
precess at a much lower frequency providing information about molecular 
dynamics in a frequency range of kHz (acoustic waves) rather then in MHz (radio 
frequency) that is obtained in the laboratory frame of classical NMR.  

• If a strong enough B1 field is applied it can eliminate the effect of line broadening 
due to magnetic field inhomogeneity ∆B0 (Figure 89), as well as dipolar 
broadening. This can eventually permit high resolution NMR spectroscopy in 
solids where line broadening has a strong contribution from static magnetic 
dipolar fields. 

                                            
4 Use:1T=104Gs, and [T]=[NA-1m-1] to convert Tesla to Gauss. 
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Figure 89. Effect of constant magnetic field inhomogeneity ∆B0 on effective field. 

“Spin-locking” experiment illustrates the benefits of multiple power sequences with 
independently adjusted time, phase and power of the individual pulses.  This feature is 
available in the PS15 spectrometer. The sequence (Figure 1) consists of two RF pulses. 
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 Figure 90. "Spin-locking" sequence and measuerement of T1ρ. During locking, 
magnetization decreases in the presence of the B1 field (red line). Nuclear signal is not 
visible during this period due to receiver blocking by RF pulse. When locking pulse is 
off, the FID amplitude can be measured. A plot of the FID amplitude as a function of 
lock time tp will decay with T1ρ constant. 

First is a short Π/2 pulse along +x axis that moves the magnetization M0 on the  x’y’ 
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plane as seen in Figure 91a (on the x’y’ plane M0 becomes My). Soon after the Π/2 
pulse is completed a second much longer RF pulse along +y axis is applied (Figure 
91b). If B1 >> ∆B0 magnetization My and field  B1 are parallel so there is no torque 
exerted on My and magnetization is “spin-locked” to B1. As mentioned before B1 in the 
rotating frame starts to play the role of B0 in laboratory frame as B0 is entirely 
compensated by the fictitious field ω  (Figure 91c). /γR
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Figure 91. Effect of Π/2 and lock-pulses on nuclear magnetization in a rotating 
frame. 

The longitudinal relaxation process that follows along B1 is somewhat similar to spin-
lattice relaxation along B0 and is called T1 in the rotating frame characterized by a T1ρ. 
Since in a rotating frame the magnetization is polarized in a much smaller field (B1<<B0) 
therefore magnetization needs to relax from My=M0 to the  much smaller equilibrium 
value (Figure 91c). When the locking pulse ends the magnetization in x’y’ plane 
inevitably decays very quickly due spin-spin relaxation (Figure 91d). 

Spin-lattice relaxation in the rotating frame is closely related to spin-spin relaxation in 
the laboratory frame and with the absence of a locking B1 field, the relaxation along y’ is 
of course characterized by T2.  In liquid samples this is essentially the same time. For 
instance, when problems with a cumulative error in the train of Π pulses in the standard 
multi-echo method occur, then spin-locking is more accurate for determining spin-spin 
relaxation times. 
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6.2.2 Experimental. T1ρ in rubber and in acrylic. 
Object 
Measurement of spin-lattice relaxation time in rotating frame T1ρ by “spin-locking 
method”. 

Note: 
Regardless of the sample used in performing a T1ρ experiment in a rotating frame there 
are three elementary steps. 

• Estimation of the local magnetic field ∆B0. Measurement of line width at half 
height in [Hz] and recalculating it to [Gs] is a good measure of the local magnetic 
field distribution.  

• Lock pulse calibration to determine if the B1 magnetic field is strong enough to 
cause spin locking. Assure the correct conditions for spin locking are met when: 
B1 >> ∆B0. 

• Measurement of free induction decay amplitude as a  function of the locking 
pulse length and final calculating of T1ρ. 

Instructions: 
Estimation of the local magnetic field ∆B0 

1. Insert sample (we recommend  starting with a rubber sample) in a 
sample holder, 

2. Switch spectrometer to Spectroscopy Mode, 
3. Load one-pulse method 1P_X, 
4. Set  parameters to acquire FID signal in orthogonal channels (I&Q), 
5. On the Acquisition page acquire FID signal and store it in a file on disk. 
6. On Acquisition page perform FFT of the signal. 
7. Calculate line width at the half peak, 

∆B
2Π
γf =8. Using formula ∆ (γ=2.6752 [kg-1sA], 1T=104Gs) convert line 

width units from frequency domain in [Hz] to magnetic field domain in 
[Gs].  

Lock pulse calibration  
1. Switch spectrometer to Relaxometry Mode 
2. Load method SL_cal to calibrate the spin locking pulse, 
3. In theTransmitter window set the attenuator in the Y channel to zero 

 and determine the length of tΠ pulse5, 
4. Repeat measurement of tΠ for all available attenuations of the pulse (0 

through 7), 

                                            
5 Simply start with the shortest available pulse, increment it by 0.2µs and watch for 
when the FID signal goes through maximum and becomes zero. For details refer to text 
on page 17. 
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Due to the power supply limit, the PS15 transmitter can not operate with full 
power of 20 W with a duty cycle6 above 1%. To avoid a decrease of power of 
the pulse or safety blanking of the transmitter by the software, adjust 
repetition time tR according to locking pulse length. For example, using a 
locking pulse of the maximum available power and a time of (100ms) set TR 
no less than 10s. 

T1ρ measurement 
1. Load method spin_lock to measure T1ρ,   
2. Adjust parameters on Setup Page to get a strong on-resonance FID 

signal after the locking pulse (similar to these on Figure 92 ). For better 
usage of the dynamics of the ADC converter move signal noise line 
below zero level. 

 

Figure 92. Setup page for T1ρ measurements in rubber. 

3. Measure FID amplitude as a function of locking pulse width. 
a. Manually:  

                                            

%100⋅=
R

p
d t

t
f6 Duty cycle is defined as , where tp is pulse time, tr is repetition time. 
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• by changing the pulse width of spin locking pulse Y(VTD)_2 
and recording the amplitude of the FID using the horizontal 
or vertical cursor. To see FID in the same position on the 
screen select acquisition triggering after the locking pulse (in 
Programmer window set Trig box to P2) . 

b. Automatically by: 
• creating on the Acquisition Page a file with different times 

for Y(VTD)_2, 
• performing an automatic change of the Y(VTD)_2 pulse and 

simultaneous acquisition of corresponding FID, 
• storage of the complete experiment in a file.  

Please remember that automation  of the algorithm of data processing 
requires the setting of acquisition triggering after the locking pulse 
(Trig P2). 

4. If data are acquired manually use any program capable of performing 
regression analysis of the natural logarithm of FID amplitude as a 
function of Y(VTD)_2 pulse width (Excel, Origin), 

5. If data are acquired automatically go on Processing Page, load data 
file, extract data points and calculate T1ρ by  clicking on SL button. 

. 
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T1ρ in rubber 
This part of the Manual presents a summary of experimental data used to determine T1ρ 
in rubber. 
 

 Estimation of local magnetic field from spectrum line width 
An NMR spectrum obtained from rubber is shown in Figure 93.  The acquired FID was 
multiplied by an exponential function to improve S/N. This multiplication broadened the 
spectrum by 50 Hz. After a 50Hz subtraction, the effective line width of the spectrum is 
∆f0=800 Hz and corresponding ∆B0=0.2Gs. 

 

Figure 93. Rubber sample. NMR spectrum after FTT with 50Hz line broadening. 

 Lock pulse calibration  
Figure 94 and Figure 95 and present calibration data of a PS15 unit. Notice that the 
attenuator on the Y-channel permits the change of B1 field from 5Gs to 17Gs. Even with 
the highest attenuation of 7dB the B1 field (5Gs) is still much higher than the magnetic 
field inhomogeneity (0.2Gs). 
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Figure 94. Pulse length of Π pulse for its different attenuations. 
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Figure 95. B1 field calibration chart. 

 Measurement of FID amplitude as a  function of the length of  the locking 
pulse 

Manual measurements 
The experiment with rubber was performed with maximum locking pulse power  
producing B1=17Gs which highly exceeds the static field inhomogeneity estimated from 
line width ∆B0=0.2Gs Time of the locking pulse was varied from 0.2ms to 10ms. Figure 
96 shows stack plot with several FIDs. 

 

Figure 96. Exponential decay of the amplitude of FID signals in rubber for different 
locking times. 

The dependence of FID amplitude on the locking pulse width with corresponding linear 
regression is shown in Figure 97. Regression is shown in red: Y=4.71 – 0.35tp. The final 
value of spin-lattice relaxation time in the rotating frame in rubber is T1ρ=2.8 ms. 
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Figure 97. Linear regression analysis of the logarithm of FID amplitude vs. locking pulse 
length with an Excel program; T1ρ=2.8 ms. 

Automatic measurements 
Data acquired automatically on Acquisition Page can be processed on Processing 
Page: 

• -load data, 
• -extract data points (FIDs amplitudes with corresponding locking pulse width), 
• -perform regression analysis clicking on T1ρ by spin lock SL button. 
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T1ρ can be measured for different locking pulse power. As mentioned before this 
corresponds to measurements of relaxation in a rotating frame in different magnetic field 
(T1ρ dispersion). 

T1ρ in rubber - B1 dependence
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Figure 98. Processing data from T1ρ experiments in rubber. T1ρ =2.8 ms is the exact 
value obtained with manual measurements and linear regression using Excel. 

Figure 99. T1ρ in rubber measured for different magnitude of B1 magnetic field. 
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T1ρ in acrylic 
Since an acrylic sample is a typical solid-state sample it is definitely more challenging in 
measurements of T1ρ than is  rubber. 
Acrylic’s short FID time requires very careful adjustments of: 

• receiver filter (set time constant to 1µs), 

• preamplifier gating (set it below spectrometer’s “dead time”), 

• acquisition time (Dwell Time 0.4µs and Number of Points NOP=1024) 
Relatively weak signal needs:  

• more Receiver Gain, 
• at least 100 accumulations to improve S/N ratio 

Since T1ρ is longer than in rubber the expected longest locking pulse will be relatively 
long (about 40ms). Despite short relaxation in acrylic the experiment can not be pulsed 
too fast due to spectrometer’s transmitter limit. If repetition time TR is too short the 
locking pulse will simply lose the power before it reaches its end. Use a longer repetition 
time to let the transmitter’s power supply  recharge capacitors. Figure 100 through 
Figure 103 illustrate the importance of proper TR time selection. 

 

Figure 100. Sudden drop of FID amplitude from acrylic due to locking pulse power 
decrease at 26ms (TR=1s) 

 

Figure 101. Decrease of transmitter power significantly affects accuracy of T1ρ 
measurements. 
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Figure 102. Unaffected, smooth exponential decay of FID amplitude from acrylic 
(TR=5s). 

 

Figure 103. Highly accurate measurements of T1ρ in acrylic when experimental 
repetition time is long enough to prevent locking pulse drop. 
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6.3 Multiple spin echoes in three pulse sequence 

6.3.1 Introduction 
In his classic paper “Spin Echoes”7, E. Hahn introduces the concept of pulsed NMR and 
an idea of Π/2 pulses. He was so attached to the rotation of nuclear magnetization by 
90 degrees that even the first nuclear spin-echo, which he called a product of 
“constructive interference”, is generated by Π/2-τ- Π/2 sequence (Figure 104) not by the 
Π/2-τ- Π as we do now. To explain the formation of the echo after two Π/2 Hahn uses a 
somewhat cumbersome three-dimensional “eight-ball” echo pattern. 

A  much simpler two-dimensional vector model can be used when the echo is created 
by the Π/2-τ- Π sequence where the  movement of spins is reduced to the x’y’ plane 
(Figure 105).  

 

Figure 104. Classic Hahn's spin-echo from water doped with cupric sulphate obtained 
with two identical pulses (3.6µs-10ms-3.6µs). 

 

Figure 105. Spin-echo signal after Π/2-τ- Π sequence (3.6µs-10ms-3.6µs). 

                                            
7 E. L. Hahn, “Spin Echoes’, Phys. Rev. 80, 589-594 (1950) 
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When after a time T with respect to t=0 the third identical radio-frequency pulse is 
applied to the  (Π/2-τ- Π/2) sequence, four additional echoes appear at times: T+τ, 2T-
2τ, 2T-τ, 2T. Figure 106 shows the formation of “primary echo” and four “secondary 
echoes” in a distilled water sample. This experiment is a reproduction of Hahn’s original  
experiment using the PS15 spectrometer. One difference is that the PS15 phase-
sensitive detector can see the actual polarity of echoes (positive when echo is formed 
along +y’ and negative when is formed along –y’ axis).  

 

Figure 106. Formation of multiple echoes in distilled water by (Π/2-τ- Π/2-TD-Π/2) 
sequence: Π/2=3.6µs, τ=10ms, TD=25ms, repetition time TR=10s 

Diagram on Figure 107 shows timing of the appearance of consecutive echoes. Note 
that secondary echoes have different polarities with the sign depending on whether the  
spins focus is  in x’y’ plane along –y’ or along +y’ axis. 
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Figure 107. Three-pulse sequence and multiple echoes: P1, P2, P3- radio-frequency Π/2 
pulses. SE1-primary echo, SE2, SE3, SE4, SE5 -secondary echoes  (SE2-Stimulated 
Echo, SE3-“image echo”). 

Among secondary echoes the so called "stimulated echo" is particularly useful due to 
its exponential decay ruled by the 1/T1 term.  If τ is small enough a plot of stimulated 
echo amplitude versus T gives a straight line whose slope is the measure of T1.   

Stimulated echo importance goes far beyond NMR applications. Newly developed 
pulsed Electron Paramagnetic Resonance techniques utilize the modulation of 
stimulated electron spin-echo by nuclear spins to measure distances between the 
paramagnetic center and surrounding nuclei in amorphous materials. 

6.3.2 Experimental 
Object 
Observation of multiple echoes and spin-lattice relaxation times measurements by 
Inversion Recovery and Stimulated Echo decay in water-cupric sulphate solution. 
Cupric sulphate was added to reduce T1 relaxation time in water and make 
measurements shorter. 

Directions 
T1 measurements by Inversion Recovery 

• Automatically generate experimental data following instruction on page 48.  
• Calculate T1 either on Winner Processing page or using any other program 

(Excel, Origin, etc) 

T1 measurements by Stimulated Echo. Follow guiding points on the Setup page on 
Figure 108.  

• Switch Spectrometer Mode to Spectroscopy and Method to 3P_X_D (1). 
• Change data acquisition triggering moment Trig from P1 to P3 (2). This will 

start data acquisition after the end of third pulse.  
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• Place cursor on the center of stimulated echo (3). 
• Set Delay Time TD between second and third pulses (5). 
• Measure echo amplitude A (4). 
• Repeat measurements for longer delays until stimulated echo disappears in 

the noise.  
• Using any statistical program do regression analysis of ln (|A|) versus delay 

time TD. 

 

Figure 108. For T1 measurements select and use the 3P_X_D method (1), set triggering 
after P3 pulse (2), place measuring cursor on the center of stimulated echo (3). Due to 
short relaxation the third secondary echo is not visible. 

• Author used Excel program to create spreadsheet with A vs. TD data points, 
perform Tools>Data Analysis>Regression, and to display experimental 
data points and regression on the chart (see Figure 109). 

• Following table summarizes measured T1 relaxation times by both methods 
with additional T2 obtained by Carr Purcell Meiboom Gill method. 
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Method Relaxation time [ms] Error [ms]
T1 by Inversion Recovery 117 2
T1 by Stimulated Echo decay 128 5
T2 by CPMG 97 2

Table 6 . T1 relaxation times in cupric sulphate doped water by Inversion Recovery and 
Stimulated Echo. T2 time measured byCPMG method is of the same order. 

T1 in H2O+ CuSO4 

time delay TD [ms]

from Stimulated Echo

1.50

2.00

2.50

3.00

3.50

4.00

4.50

5.00

0 100 200 300 400

S
tim

ul
at

ed
 E

ch
o 

am
pl

itu
de

 
A

 [a
u]

A=5.1 - 0.0078*T
T1=(128 +/-5) ms

 

Figure 109. Experimental data points (black) and regression analysis (red line) using 
Excel program. 
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777   APPENDIX 

 

7.1  How to load and display relaxation data in ASCII format using 
EXCEL  

 
1. Prepare the relaxation data ASCII file in the PROCESSING page of the PS15 

program, 

2. Start EXCEL, 

3. Load a data file by: File/ Open/All files [data file name and path]. In our example 
we will use later gl_t1.prl file.  

4. EXCEL recognizes immediately that the data format is not EXCEL format and it 
launches the Text Import Wizard. Follow three steps: 

 
Step 1 of 3   
 Original data type- Fixed width 
 Start import row at- 48 
 File origin- Windows (ANSI) 
 Next> 

 
 

Step 2 of 3   
 This is Data preview. Check if columns are set properly. If 

not use CREATE, DELETE, MOVE a break line. 
 

Step 3 of 3   
 Column data format- general 
 Finish  
 

5. Data without data header are loaded. Now remove data footer: 

• Mark footer text  
• Select Edit 
• Select Clear 
• Select All 

 
6. Save data in EXCEL format 

Save As   
 File name [type a file name] 

                                            
8 Data header contains always 3 lines 
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 Save as type [MS Excel Workbook] 
 Save  

 
7. To display data as an X-Y diagram choose Chart Wizard from Insert>Chart. 

Follow these four steps: 

Step 1 of 4   
 Chart type: X-Y (Scatter) 
 Chart sub-type: Scatter. Compares pairs of 

values 
 Next> 

 
 

Step 2 of 4:   
 On data sheet click the range of points to be displayed.  A 

preview of the data immediately appears. 
 

Step 3 of 4    
 Titles:   
  Chart title Magnetization recovery in 

glycerin 
  Value (X) axis: Delay time [ms] 
  Value [Y) axis: Mz [a.u.] 
 Axes:   
  Value (X) axis check 
  Value (Y) axis check 
 Grid lines   
  Value (X) axis: Major grid lines 
  Value (Y) axis: Major grid lines 
 Legend   
  Right  
 Data label None  
 Next>   
    
Step 4 of 4   
 Place Chart As an Object in [gl_t1] 
 Finish  
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Figure 110. Magnetization recovery in glycerin. Excel presentation. 

8. Now you can change specific items on the chart by double clicking and modifying 
it according to your requirements. 

9. Save the whole project under the new name [gl_t1_diagram]. 

7.2 How to process relaxation data with Excel program 

Excel’s SOLVER package provides tools powerful enough to fit relaxation data into 
specific equations.  If the SOLVER command is not on the TOOLS menu, you need to 
install it. Select Tools>Add-Ins. On list of available Add-ins check Solver and follow 
instructions. 

 

Figure 111. Installing Solver from Tools>Add-Ins. 
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Using data for glycerin and assuming a simple one parameter data fit to equation: 
M=M1*(1-2*exp(-t/T1)) we will obtain the spin-lattice relaxation time T1=46.3 ms. 

We can get a better fit with a two- or three-parameter equation but you will encounter 
some difficulties in interpreting the physical meaning of the parameters. 

• Load experimental data to columns A and B. 
• Estimate the maximum value of magnetization in cell E3: M1=118 
• Estimate T1 in cell G3: T1=100 
• Select range C3:C18: and perform calculations of theoretical 

magnetization values: {=F3(1-2*exp(-(B3:B18)/G3)}. 
• Select range D3:D18 and perform calculations of squared errors:  

{=(C3:C18-D3D18)^2} 
• Do sum of squared errors by E19=SUM (E3:E18) 
• In Tools select Solver and complete items in a Solver Parameters box 

(Figure 112): 

 

Figure 112. Options in Solver Parameters box. 

 Set Target Cell, which is sum of squared errors in cell E19 
 Select Min to minimize sum of squared errors in cell E19 during fitting 

procedure 
 Select T1 in G3 cell as adjustable cell (in By Changing Cells box) 
  Click Solve to perform calculations. 

Figure 113 shows all elements of calculation of T1 with Excel Solver tool. 
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1/A B C D E F G
2 delay [ms]Mz [au] M Error^2 M1 T1
3 1 -81 -112.95 1021.03 118 46.3
4 2 -82 -108.02 676.78
5 4 -72 -98.45 699.74
6 8 -60 -80.52 421.24
7 16 -37 -49.00 143.99
8 32 -1 -0.17 0.68
9 50 30 37.92 62.66

10 75 62 71.35 87.40
11 100 81 90.82 96.52
12 150 102 108.78 45.94
13 200 111 114.87 14.98
14 250 115 116.94 3.76
15 300 116 117.64 2.69
16 350 118 117.88 0.01
17 400 119 117.96 1.08
18 500 118 118.00 0.00
19 3278.51 Sum of Error^2

SUMMARY
equation used: M=M1*(1-2*exp(-t/T1))
result from the Solver: M1=118 [au], T1=46.3 [ms]
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Figure 113. Excel worksheet with data and chart. 
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7.3 How to load and display relaxation data in ASCII format using 
ORIGIN program 

Procedure 
1. Prepare the relaxation data ASCII file in the PROCESSING page of PS15 

main program, 
2. Start Origin, 
3. Begin session with File>New>Project 
4. Import data file by: File>Import>ASCII Options 
5. Complete ASCII Import Options following hints in Figure 114. 

   

Figure 114. Origin program import ASCII options and data after importing from *prl file.. 

6. Start Import ASCII by Import Now.  
7. Browse through All Files (*.*) types. 
8. Select right file name *.prl and Open it. 

You should now have data loaded without the header and footer. Double check to 
confirm that the number of columns and rows are correct. Assure that the header and 
footer are completely removed. Figure 114 shows ASCII Import Options dialog window 
and set of correctly imported data. 

9. Proceed to save project by: File>Save Project As in *.opj file. 
10. To display experimental points select Plot>Scatter and complete procedure 

by assignments of columns for plot in Select Columns for Plotting. 
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Figure 115. To plot experimental data select right columns and click OK. 
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7.4 How to process relaxation data with Origin program 

There are many ways to calculate T1 from an experimental data set. A non-linear curve 
fit is one of most reliable and elegant methods. This option in the Origin program 
provides a flexible and easy to use tool to find the parameters of the exponential 
function that describes the magnetization recovery after the Π pulse in the inversion 
recovery method. Theoretically a one- exponential fit (see Eq.  30) requires at least a 
two parameters. One of the parameters is an equilibrium magnetization M0, another 
spin-lattice relaxation T1.  

 Eq.  30)exp(-t/T 2-(1M (t)M 10z =

Translated into Origin language this equation looks like:  

.(-x/P2) exp * 2-(1*P1Y =  Eq.  31

1. Start Analysis>Non-linear curve fit.  

   

Figure 116. Function and Action options in a Non Linear Curve Fitting.  

2. From Functions>Select load fitting function by highlighting the proper 
function in Categories (Figure 116). 

3.  If there is no appropriate fitting function create a function by Function>New 
or Function>Edit. 
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Figure 117. Fitting experimental data with two and with one parameter. 

4. In Action>Data Set assign  
5. Perform fit in Action>Fit. 

 Type approximate values for P1 (M0) and for P2 (T1). 
 Check Vary? box if parameter should vary during iteration. 
 Do iterations.  
 Finish by Done when results satisfy you or when there is no further 

improvement with more iterations. 
6. After fitting you can modify fonts, colors, appearance of labels, etc using 

options in Format>Plot. 
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Figure 118. Fitting experimental data for T1 calculation in glycerin using Origin program. 
Red line is one-parameter and blue line is two-parameter fit. 

Final results of calculations of T1 in glycerin sample by fitting to the same experimental 
data set using different programs are presented in Table 7.  

 M0 [au] T1 [ms] Error [ms] This manual page

PS15 110 47.0 ±3.3 54 

Excel 118 46.3  123 

Origin 118 46.0 ±4.0 128 

Table 7. Summary of T1 calculations in glycerin by different programs. 
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